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Before you begin

Before you begin

Conventions

Assumptions

The following conventions are used in this manual:

Formatting convention Type of information

2 2 Step by step procedure

Plain courier type Directory, record, file, and

System messages

This documentation assumes that you know how to use a
scanner and a PC, and that you are familiar with a mouse and the
Microsoft Windows environment. It also assumes that an image
server and 1Scan have been successfully installed. See the 1Scan
Installation Manual for instructions for installing 1Scan and see
the TMAGE Installation Guide for instruction for installing
TMAGE.

Included in this manual are procedures for the use of both 1Scan
and Tool Scan, 1Scan’s configuration program.

Tmage Software Inc.
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Background

Background

Tmage’s scanning software provides an efficient interface
between a diverse range of production grade scanners and the
1MAGE server. In addition to scanning images, 1Scan appends
information about each scanned image to an image .dat file.
TMAGE server uses this information to facilitate fast and accurate
indexing of each image into the 1TMAGE database.

Tmage scanning software consists of two executables programs:
1Scan and its companion, ToolScan. ToolScan is used to
configure 1Scan. Itis used to specify the name of the image
server to connect to and the local work area (capture path)
where images are temporarily stored until they are transferred to
the image server.

1Scan is Tmage’s scanning application. 1Scan applies industry
accepted compression standards to the digitized image of a
document in order to decrease the amount of space needed to
store the image. An image remains in this compressed form
until it is uncompressed to be viewed, faxed, or printed. 1Scan
also provides a windowed environment to be used by a
scanning operator to “inspect” a digitized image before it is
queued for indexing and archiving or removed from the queue
to be re-scanned.

To help the image server store the digitized image, 1Scan
software creates two records for each scanned document: an
image record (image.tif) and a companion data record
(image.dat).

Image record /» Data record

image.tif image.dat

*B <Batch code>
*D <Date>

*T <Time> B
*O  <Operator’s initials>
* <Image type>

*K1 <Index key 1>

*K2 <Index key 2>

*K3 <Index key 3>

*BC <Barcode read>
*WF  <Workflow queue>
*A  <Next page flag>

*C <Comments>

*Z End of file flag

Audit trail and
indexing data

The image record stores a compressed digitized bitmap of the
scanned image. The data record stores indexing and audit trail
information until an image is indexed. Stored data is marked by
an asterisk in the .dat file. After indexing, the data is filed in the

Tmage Software Inc.
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What's New

What’s New

TMAGE.DETAIL and TMAGE.MASTER files on the image server
and the data file is deleted.

1Scan 10.2.1 is the first release of 1Scan that supports queue
security. Queue Security is a new 1MAGE feature that allows
only those users known to the image server to use
ToolScan/1Scan, and only allows specific TMAGE users access to
predefined scan queues on the image server. Users with
scanning privileges still have the flexibility to create their own
batches to organize their scanning work. However, users must
first pick from a list of scan queues when logging into 1Scan.

In order to enforce queue security, significant changes were
made to the way 1Scan interacts with the image server and to
the way scanned images are transferred and stored. These
changes require that 1Scan now recognizes whether or not it is
connecting to image server version 8.1. When 1Scan connects to
1TMAGE 8.1, all the new queue security features are available.
When 1Scan connects to TMAGE 8.0a or earlier, 1Scan functions
the same as in earlier releases.

Information in this user guide is organized into four parts. The
first part covers information that users need to know when
connecting to a TMAGE 8.1 Server. The second part discusses
what users need to know when using 1Scan 10.2.1 to connect to
1MAGE 8.0a Server versions or earlier. The third part discusses
general 1Scan procedures. The fourth part discusses common
troubleshooting procedures.

Tmage Software Inc.
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Connecting to TMAGE 8.1+ server

Connecting to TMAGE 8.1+ server

ToolScan must be configured prior to running 1Scan. Use the
following procedures to configure ToolScan
Accessing ToolScan
To start ToolScan click the ToolScan icon on the desktop.
ToolScan Login Setup

The first time ToolScan is run, the ToolScan Login Setup screen
displays.

ToolScan Login Setup

Server

Image Host: |m_l,l_imagerewer

Part: |2222
Login

M ame; |image
Optionz

Timeout [sec) |50 Tracing v

Promsy

Frosy Host: |

Part: |

[u] Cancel | Help |

Use information in the following table to configure ToolScan.
This table lists and defines each of the fields for this screen

Fields:

Image Host Enter either the IP address or hostname.

(required) Entering the IP address instead of the
hostname assures connectivity even if the
host file is not up to date.

Port - The default port number, 2222, displays. If

(required) you are already using port 2222 for another
connection, enter an alternative port number
here.

Login Name Enter a login name. Only user names defined

(required) on the imageserver are allowed to connect to
login to ToolScan/1Scan.

Options Timeout is the amount of time 1Scan will

wait for a response from the image server. If

Tmage Software Inc. 1Scan User Guide, ©2019 4



Connecting to TMAGE 8.1+ server

Proxy

1MAGE takes longer than the amount of time
defined here then 1Suite display a “recv () call
timed out” message and 1Scan will close.
Typically, the value is set to 60 (sec) but may
be adjusted upwards if you think you will be
undertaking lengthy cross-reference
searches.

Tracing - records the communication traffic
from ISP. Enable this option only if you are
experiencing difficulty with ToolScan.

Use Proxy settings if 1Scan will be connecting
through 1Proxy. 1Proxy provides a way to
connect to the image server through a
firewall.

Proxy Host - enter the IP address of Proxy
Host.

Port - The default port number, 4444,
displays if you populate Proxy Host.

Once you have entered all of the required information, click OK.
The ToolScan Login screen displays.

Help

User Name:  |image
Password: |

0K I Setup I LCancel |

Enter a valid user name and password. Only user names defined
on the image server are allowed to connect to login to

ToolScan/1Scan.

Tmage Software Inc.
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Connecting to TMAGE 8.1+ server

Design (Tool Scan)

The configurations settings that display is different when
connecting to TMAGE server 8.1+ than it is when connecting to
earlier TMAGE versions. The following sections discuss the
configuration options for connecting to different versions of the
image server.

When using ToolScan to connect to a TMAGE 8.1+ server, only
the following three fields are required to connect to the image
server.

Capture Path Enter the path on the local machine are
where scanned images will be stored before
they are transferred to the image server.

Batch Enabled  Check this box to enable batch mode

scanning.
Scanner ID Enter two alphanumeric characters that will
Number uniquely identify this scan station on your

network. For example, S1.

The "Starting Sequence Number field is for reference only. This
field displays then current number that will be assigned to the
next scanned image.

ToolScan - For engpc? Release B.1 @|
File ©ptions Help

Capture Path |e:vreciunindexed

Batch Enabled v

Scanner ID Humber 21

Starting Sequence Number

Cancel |

Note: The options menu item contains one option to configure
imprinting. This is an optional feature that is available only for
Bell and Howell scanners. See the instructions for enabling
Imprinting on page 25 for more information.

Tmage Software Inc. 1Scan User Guide, ©2019 6



Connecting to TMAGE 8.1+ server

Accessing 1Scan

1Scan Login

Click the 1Scan icon on your desktop. The 1Scan Login screen
displays.

Help

User Name:  |image
Password:
ok | ofine | Setp | Concel |

Enter a valid user name and password. Only user names defined
on the image server are allowed to connect to login to 1Scan.

If you wish to view the 1Scan Login settings, click setup. Click
Setup. The 1Scan Login Setup screen is similar to the ToolScan

Login Setup screen.

15can Login Setup

Server

Image Host: |

Part: |

Login

Mame:

Options
Timeout [sec)  |BO

Frow=y

Tracing v

Prosy Host: |

Part: |

] Cancel Help

Tmage Software Inc.
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Connecting to TMAGE 8.1+ server

The fields are defined with settings that were entered from
ToolScan. Only the Login Name and Options fields may be
edited. The Server and Proxy setting must be defined in
ToolScan.

Select Queue and Batch

Every user who logs into 1Scan is prompted to select a Scan
Queue and (if Batch option is enabled) enter a batch name. Only
scan queues defined in TMAGE administrator’s interface (Scan
security by user) for this user display in the Scan Queue field.

15can - Select Queue And Batch

Scan Queue:; HBLC Fiwe QUELIE

B atch Mame: |

ag. Cancel |

If the user has privileges to access more than one scan queue the
Scan Queue field present the option to select a queue from a
pick list.

15can - Select Queue And Batch

Scan Queue: |.$.EE Fis AJELE ﬂ

:I o

gCanner 2
[ oK Caneel |

Enter a batch name. This can be any name you like. However,
the name cannot contain spaces or special characters. See “To
enter a batch code” on page 37 for more information on rule for
batch names.

B atch Mame:

Tmage Software Inc.
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Connecting to TMAGE 8.1+ server

After a successful login, the main 1Scan view window displays.

ile  Scanmer  Server Wiew Queus  Options  Pre-Indexing Help

o

Hmi“_ﬁ\@ o

L
L
L

=

| Ready | Single Scan | onlineVABC1 0/0

The bottom of the view window displays a status bar containing
the following information:

e 1Scan status indicates whether 1Scan is initializing, ready to
scan, or is in process of scanning.

e Scanning mode indicates whether 1Scan will scan in single
scan mode or in duplex mode. When scanning in duplex
mode both the front and back page displays side by side in
the view window.

e Queue\Batch code name indicates the path where scanned
images are stored. This path reflects the server connection
state (online vs. offline), the queue name, and the batch
name.

e Location within the batch indicates the location of the
currently displayed image in the batch. For example, if you
are viewing image 3 out of batch containing six images, this
value would appear as 3/6.

¢ Image counter indicates the total number of images scanned
in the current session.

Tmage Software Inc. 1Scan User Guide, ©2019 9



Connecting to TMAGE 8.1+ server

Accessing 1Scan Offline

1Scan validates users against the image server. As aresult,
scanner operators connect directly to the image server when
they log into 1Scan. However, there may be times where it is not
possible to establish a connection with the image server and
there is scanning work that still needs to be completed. 1Scan
accommodates for this possibility by providing an "offline
scanning" feature. Images can be scanned and stored locally on
the scan station for as long as necessary. When connection to
the image server is restored 1Scan prompts the user to transfer
any or all of the batches available for transfer when the user logs
into 1Scan.

To use 1Scan “offline” start 1Scan as you normally do. When the
1Scan login screen displays, click Offline.

UserName:  |image
Password: _— Click Offline to start
1Scan offline.

ok | offine | setw | Cancel |

Tmage Software Inc.
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Connecting to TMAGE 8.1+ server

The 1Scan User Login for offline scanning displays.

15can User Login - Offline

Idzer Mame:

0k, Cancel |

This screen displays the username for the last valid login. Press
OK or enter a valid user name. If an invalid user name is entered
a message displays stating ‘User "<username>" has not been
assigned a scan queue. Cannot continue.” 1Scan closes.

IUser “imag" has not been assigned a scan queue, Cannot continue.

Once you have successfully logged into an offline 1Scan session
the 1Scan Select Queue And Batch screen displays. If a user has
privileges to access more than one scan queue, the Scan Queue
field presents the option to select a queue from a pick list. Select
the desired queue and enter a batch name. The main view
window displays.

File Scanner Server Wiew Batch Options  Pre-Indexing Help

=
5

L
L
L

[ |G |

| Ready | Single Scan | offline\FAX2\batch1l 0/0

Tmage Software Inc.
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Connecting to TMAGE 8.1+ server

Users may scan in offline scanning mode, just as they would in
online scanning mode. However, user will not be able to transfer
scanned images to the image server until the next time the user
logs into 1Scan in online scanning mode.

Scanner S No Transfer option

— displays when 1Scan
connects to 1IMAGE
8.1 in offline mode.

Exiting 1Scan when scanning is complete

Select Exit from the File menu. If the user has logged into 1Scan
in online mode and if there are images available to be
transferred the Transfer Images dialog box displays.

15can - Transfer Images To engpc2

Source | Queue | Batch | Count | Users
ioffine. ABCEUELIE 1 e 1 imaaqe
anline ABCQUEUEN batchl 2 image
online ABCQUELEN Hr2987 1 image

| Cancel

Select the batches to be transferred.

Note: Press the Ctrl key to select multiple batches or press Ctrl-A
to select all of the batches.

15can - Transfer Images To engpc?

Batch Count | Uszers

(batchl 17 limage |
JEUE 1

Source | Oueus

Transfer | Cancel |

The Transfer button will be enabled. Press Transfer to send the
batches to the image server. Once the transfer is complete,
1Scan closes.

Tmage Software Inc. 1Scan User Guide, ©2019 12



Connecting to TMAGE 8.0a (or earlier) server

Connecting to TMAGE 8.0a (or earlier) server

When ToolScan or 1Scan connects to a 1MAGE server version
8.0a or earlier, the legacy interface for ToolScan or 1Scan
displays. Scanned images must be transferred to the image
server using one of the transfer methods available in ToolScan.
The Transfer method must be defined and configured before
using 1Scan. The following sections describe how to access and
configure the legacy ToolScan interface.

Accessing ToolScan

ToolScan is a configuration utility for 1Scan. It defines the path
to the image server and how image transfers will be managed.

Tool Scan may be configured to accommodate special business
needs, such as:

e Grouping images in batches by scanner ID

e Imprinting images at scan time with the system date, time,
batch number and operator initials

¢ Modifying how images are transferred to operators for
indexing.

e Establishing temporary holding locations — a drive or
directory — for batches of images in order to implement
recognition or enhancement technology

Access

To access Tool Scan, double click on its icon.

e

Tool Scan

Tool Scan settings may be viewed in read-only mode from the
Settings option of the 1Scan File menu.

Navigation

ToolScan settings may be accessed using the pull down menu
and/or keyboard commands. This manual will document
keyboard commands and the 1Scan tool bar.

To access main menu options using mnemonics, hold down the
Alt key and type the item’s mnemonic; to access a submenu
option, simply type the mnemonic. For example, to access the
Options menu, hold down the Alt key and type o.

Tmage Software Inc. 1Scan User Guide, ©2019 13



Connecting to TMAGE 8.0a (or earlier) server

Design

The Tool Scan dialog box displays three menu options: File,
Options, and Help; a check box; and five data entry fields:
Scanner ID Number, Capture Path, Transfer Method, Starting
Sequence Number, and Root Server Path.

ToolScan - For imageas4 Release 8.0a [‘S_<|
File ©Options Help —
Capture Path |-:::\prugram files\1mage J

Batch Enabled -

Scanner ID Number ls1

Starting Sequence Number li

Transfer Method Mothing J

Root Server Path |c:\program files\1mage J
Cancel |

File submenu choice is Exit.

ToolScan - For, imageas4 Release 8.0a

58 Options Help
Bt Path |c:\program files\1mage J
Batch Enabled -
Scanner |ID Number ls1
Ctarting Sequence Number li
Transfer Method MNothing J
Root Server Path |c:\program files\1mage J
Cancel |

Options submenu choice is Imprint Setup....

Tool5can - For, imageasd Release 8.0a

=0 Cptions WaEs
(  Imprint Setup |c:\program files\1mage J
Batch Enabled |_
Scanner |ID Number 51
Starting Sequence Number ,7
Transfer Method Nothing J
Root Server Path |c:\program files\1mage J
Cancel |

Tmage Software Inc. 1Scan User Guide, ©2019 14



Connecting to TMAGE 8.0a (or earlier) server

Help submenu choices are Index and About Tool Scan...

Tool5can - For, imageasd Release 8.0a

File Options H&E]s
Capture F Index \program files\1mage
About ToolScan ke 3 J

Batch Enoorew 1

Scanner |0 Humber 21

Starting Sequence Number

Transfer Method HNothing

Root Server Path |c:\program files\1mage
Cancel |

About Tool Scan provides release and version information.

About ToolScan r5_<|

ToolScan

F” Releaze 10.2.1
15can Setup Program

Copyright [c] 2000-2005 by 1mage Software, Inc.

Tmage Software Inc. 1Scan User Guide, ©2019 15



Connecting to TMAGE 8.0a (or earlier) server

Using ToolScan to set up 1Scan

The following sections define each of the fields and
configuration options for ToolScan.

Caution: Do not run Tool Scan when 1Scan is running!

If Tool Scan is running while 1Scan is active, changes made by
Tool Scan may be lost when 1Scan exits and updates the
initialization file. Whenever a scan station is powered on after
initial set up, Tool Scan defaults its settings to those that were
last saved.

Enable the Batch Code option

Batch mode scanning is an effective choice for 1Scan users who
wish to organize their images into groups of images that can be
recognized by name.

1Scan users may use batch mode features to ensure the quality
of images before they are sent to the image server by reviewing
and reordering their images, or by deleting selected images, or
the entire batch.

When the Batch Code function is enabled in Tool Scan, 1Scan
displays a Batch Code dialog box immediately after the Operator
Name dialog box is populated. (See “To enter a batch code” on
page 45).

Click on the box labeled Batch Enabled if you wish to attach a
batch code to a group of scanned documents. A checkmark
appears when the option is enabled and a *B <Batch Name> is
written to the .dat file.

B atch Enabled v

Enter a Scanner ID Number (required)
Enter the name of the scanning station attached to your PC.

Use two alphanumeric characters in any combination, such as
lowercase s followed by the number of the scanning station; for
example, s1, s2. These characters become the first 2 positions in
the file name of the image and data files created by 1Scan.

Name the capture path (required)

The capture path includes the drive and directories where
images are captured. You may choose a local drive or any
remote drive with an NFS mount to the scanning PC.

1. Click on the ellipsis box. The Capture Path window displays.

Tmage Software Inc. 1Scan User Guide, ©2019 16



Connecting to TMAGE 8.0a (or earlier) server

Click on the arrow box to display a list of drives. Double click
to select a drive and then select a directory beneath the

drive.

This icon
represents a hard
drive.

This icon
represents a CD-
ROM drive.

This icon
represents a
mapped network
drive.

Capture Path

X

directorny:
|-:::"l.prm_:|ram files\1 mage =ol
b | e ~

A program files
£ 1mage software

22 e
=2 g: [\\Ntdev2\1M.. ]

=21 "Amaoelx 7M. 1

| | This is the arrow

box.

2. Confirm that the Capture Path displayed in the directory box
is correct and click on OK.

Select a File Transfer method (required)

A transfer method identifies the manner in which images are
moved from where they are captured to where they are held
until they are indexed or stored.

Tmage Software Inc.
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Connecting to TMAGE 8.0a (or earlier) server

1. Click on the ellipsis box to display the Transfer Methods
dialog box.

= Transfer Methods E|

Filemove
Moves images from wour PC o the image host using network-mounted drives.

i

Filemove

FTP
M ove images from wour PC to the image host over the intradinternet using File Transfer
Protocal [FTF). This option requires wau have an FTP login and pazsward to the image

host.
FIP

Other
Specify a program and parameters to transfer the images and therr data files. DIOS
commandz are not allowed; inztead, write a batch pragram. Create a FIF for pour
program and uze the PIF file name.

Other

J

Mothing
The image: and their companion data filez will remain where they were
captured. If you are capturing on the PC. you need to keep track of

your dizsk space.

i

Hothing

LCancel ‘

Note: Currently selected Transfer Methods are
highlighted in bold font.

Tmage Software Inc. 1Scan User Guide, ©2019 18



Connecting to TMAGE 8.0a (or earlier) server

2. Select a transfer method.

Select

To

Filemove |

Use Filemove when you wish to capture
images:

e Onyour PCand transfer them to the
image server.

e Inasubdirectory of the TMAGE indexing
queue and then transfer them for auto-
indexing.

You may move scanned images at any time

while 1Scan is running using File > Transfer

images. Each time you exit 1Scan, you will be
prompted to transfer all images still resident
in your capture path.

Filemove will detect duplicate names. If there
is a file in the transfer-to path that is the same
as a file in the capture path, Filemove will
prompt Skip or Overwrite.

1. Click on Filemove. The Filemove dialog
box displays.

— |capture path.

From: c:\15can

To: Click here to
display the
Destination dialog
ok | Cancel box.
Tmage Software Inc. 1Scan User Guide, ©2019 19



Connecting to TMAGE 8.0a (or earlier) server

w

Click on the ellipsis. The Destination
dialog box displays.

Destination g|

directory:
[y

C11A
[ 1MAGE
C115can

1 1scan_for_bss w

= ¢: [Local Dizk] b

oK | Cancel ‘

Select a destination drive.
Select a destination directory.

Destination §|

directory:

|c:\t:a|:|lurepalh

e ~
# capturepath
(L1 broken
iz
A Mdrive v

= ¢: [Local Dizk] b

oK | Cancel ‘

Click OK. The Filemove dialog box displays
with the “To” field populated with selected
destination directory.

6. Click OK. The Transfer Methods window
displays. Click OK to return to the Tool
Scan window.
Tmage Software Inc. 1Scan User Guide, ©2019 20



Connecting to TMAGE 8.0a (or earlier) server

Select To

Use FTP to move files over the Internet or
ETP over an Intranet using the File Transfer
Protocol (FTP). When you use this transfer
method, FTP must be available on your PC
and a FTP server must be running on the
image server.

1. Click on FTP. The FTP dialog box displays.

Hostname ||

Login
Pazsword

Directory |

(119 | Cancel ‘

2. Enter the following:

Hostname - Enter the host name of the
image server.

Login and Password - On UNIX systems it
is possible to set up a login exclusively
for FTP. This enhances the security of
the image server butitisn'ta
requirement.

Directory - Enter the name of the
directory into which you want to
transfer the images; for example,
TMAGE.SCANIN.

3. Press Enter or click OK.
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Select To

Other | Use Other to specify a program and

parameters that will transfer the images and
their data files. Use “Other” if there is a
required of preferred method for transferring
files on your network.

Do not use DOS commands to write your
program for Other; instead write a batch
program. Enter the path and name of the
batch file in the Other Method text area.
For instance, select Other

1. Click on Other. The Other Method dialog
box displays.

. Other Method X

OK | Cancel |

2. Place the cursor in the data entry field.
Type an executable file name (including
its parameters); do not exceed 128
characters (this method is equivalent to
Run from the Start Menu in Windows OS)
and click on OK. The Transfer Methods
dialog box displays.

Note: If the path or batch file name
contains embedded spaces, put quotes
around embedded spaces, or put quotes
around the entire statement. For
example:

“c:\Program Files\1Tmage
Software\1Scan\mybatchfile.bat”

3. Click on OK.
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Select To

= Use Nothing to leave scanned images and
M data files in the location specified by the

Capture Path. Be aware of drive issues such as
disk space or fragmentation because both .tif
and .dat files remain where they are captured.

Use Nothing when you wish to capture
images:
e Directly to a network drive (This would

typically be the TMAGE.SCANIN directory
on the image server).

e When external operations will be
processing scanned images.

1. Click on Nothing. No dialog box
displays because there are no transfer
parameters to be set.

2. Click on OK.

Starting Sequence Number

l‘ You may not reset the default starting sequence number.

1Scan advances automatically through numbers 000001 to
999999 and then rotates back to 000001. Because this six-digit
number is part of the image’s initial name, it plays a primary role
in the indexing of the images.

If, while scanning documents, the sequence number wraps from
999999 back to 000001, indexing will occur out of sequence; the
low numbered images will sort before the high numbered ones.
Therefore, if you care that your documents are indexed in the
order in which they were scanned (as in the case of multi-page
or workflow documents, for example), monitor the starting
sequence number and the documents that you are scanning so
that you do not interrupt the logic of your indexing or workflow
processes.

Root Server Path (required)

The Root Server Path is the path where 1Scan can find both
udf.ini and docs.ini files. TMAGE code file maintenance routines
create these initialization files on the server. 1Scan uses the type
codes and index keys in the udf.ini and docs.ini files when pre-
indexing occurs at the scanning station.

Tmage Software Inc.
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These files can either reside on the image server; or they can be
copied from the image server to a local drive on the local 1Scan
machine.

If these files are to be used from a local directory, they will need
to be copied from the image server. Defining a local path to the
udf.ini and docs.ini files may reduce the amount of network
communication that would be required at scan time.

If using the files on the image server the Root Server Path will
typically be the 1TMAGE/TMAGE.SCANIN location. This path is
normally the capture path if you are capturing images on the
server. Defining a path to the udf.ini and docs.ini files on the
image server ensures that the most current udf.ini and docs.ini
files are used.

1. Click on the ellipsis box. The Root Server Path window
displays.

2. Click on the “down arrow” box to display a list of drives.
Double click to select one and then select a directory within
it.

Root Server Path E|

directory:
|-:::"'|.

1 1MAGE

[115can

[ 15uite

(L] capturepath "

This is the down

|
arrow box.
This icon |g c: [Local Disk] @

represents a hard — ¢: [Local Disk] ”

drive. e d:

2 e

= g [WNidey2\ 1M ]
This icon

=1 MdmanelsAATM. 1T

represents a
mapped network
drive

3. Confirm that the Root Server Path displayed in the directory
box is correct and click on OK.
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Enabling Imprinting (optional)

When enabled, the imprinting option permits a user to affix
system information and/or static text to an image while the
image is being scanned. Imprinted text is permanently attached
to the image and displays (when it is viewed, printed, or faxed) in
a horizontal or vertical fashion originating from or terminating at
the upper left corner of the image.

Important  The imprinting option is NOT available if you are
using a Kofax Adrenaline software engine or if you are using VRS
with any scanner except the Bell and Howell 8000 series.

1.

To enable the Imprint option, select Imprint Setup from the
Options menu. The Imprint Setup window displays.

Imprint Setup

Imprint Imprint Text
|scanned on %d at %t by %o
Directi Rotati
Font Sans Serif - & Horizontal i
Si B ] c
1ze " Vertical
Background |Transparent - '
oK | LCancel | Test

Place a check in the Enable check box.

Note: If Imprintis enabled in Tool Scan, it may be toggled on
or off in 1Scan by using the Imprint Page option. If it is not
enabled in Tool Scan, the Imprint Page option will not be
active in 1Scan.

Select Serif or Sans Serif from the Font pull down menu.

A serif font displays short lines stemming from the upper and
lower ends of the strokes of a letter; a sans serif font displays
no lines. For example:

Serif font Sans Serif font

./
dd

Select 8, 10, or 12-point size from the Font pull down menu.

Select Transparent or Opaque from the Background pull
down menu.
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If you select Transparent, the portion of the image beneath
the imprint shows through. If you select Opaque, the portion
of the image beneath the imprint does not show through.

DAt IoL == Batch A10] ==
Transparent |~ | Opaque

6. Select either Horizontal or Vertical imprint text display and
then select the degree of rotation which suits the image you
are scanning. See the example below for versions of display
and rotation.

Horizontal Yertical
ABCDEFG A 5 E
B o W
0 c 9 8
T m
D © =
0 90 270

7. Populate the Imprint Text field with a variable and/or static
imprinted text.

At scan time, variably imprinted text displays dynamic
system information, such as batch name, operator name,
system date, or system time. To include dynamic system
information in an imprint, enter some or all of the following
special characters in the Imprint Text field.

Enter this | To get this dynamic system For example
special information

character

%B Batch Code A-100

%D System Date (mmddyy) 08/01/00
%T System Time (military) 16:30

%0 Operator’s initials PJA
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Static imprinted text is text that does not vary with system
changes; the same text appears in all imprints and is
appended to a series of scanned images until the text is
changed or deleted in the Imprint Setup window.

Static and variable text may be combined in the same
imprint; for example, the imprint resulting from this
combination of variable and static text, %B scanned at COS
by %0 on %D at %T hours, might display on the image or
images as, A-101 scanned at COS by LAB on 08/01/00 at
15:18 hours.

8. Click on Test to display a model imprint using the options
you selected.

9. Click on OK to save your changes to the Imprint option.
Cancel exits the Imprint Setup window without saving your
changes.

Select Save from the File menu, then select Exit from the File menu
(required)

If you exit or close without saving, Tool Scan displays the
following dialog box. Click on Yes to save your changes; No to
exit the Tool Scan program; and Cancel to return to the Tool
Scan interface.

The current settings hawve not been saved.
Wi'ould waou like to save them?

Mo Cancel

Accessing 1Scan

Note: This section describes accessing the legacy 1Scan
Interface. This interface only displays when connecting to an
image server version 8.0a or earlier. If you are connecting to an
image server version 8.1 or later see section Accessing 1Scan on
page 7.

Double click on the 1Scan icon. The 1Scan screen and the
Operator Information dialog box displays.
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15can [:]E]

File Scanmet Server  Misw  Batch  Options  Pre-Indexing  Help

T i 0

L
L
L

i

| Ready | Single Scan | b 0/0 Beset | | 0

Type your initials and press Enter or click on OK.

Operator Information

Operatar's Iritials: |

0k, Cancel

Your initials are stored in the 1Scan .dat file and transferred to
the image server after the image is indexed and stored.

If the Batch Enabled flag is set in ToolScan, 1Scan displays a
Batch Name dialog box immediately after the Operator Name
dialog box is populated.

15can - Batch

Batch Mare: |

k. Cancel

The batch name entered here will display in the batch list on the
“TMAGE batches and default queues” screen in telnet, or on the
“1Suite batches and default queues” dialog box in 1Suite.
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Exiting 1Scan when scanning is complete.

Select Exit from the File menu. If you are in batch mode and
Auto Batch Transfer is not enabled you will be prompted to
transfer batch images from their subdirectory to the capture
path.

If you are in batch mode and Auto Batch Transfer is enabled,
images in the batch directory will automatically be transferred to
the capture path.

Once the batch transfer process is complete then the images will
be transferred from the capture path to the image server
according to the transfer method defined in Tool Scan.

Transfer Result

Method

Nothing 1Scan quits immediately. The images remain in
the defined capture path.

Filemove 1Scan displays an image transfer dialog box.

Click on Start Transfer. 1Scan automatically
transfers the images from the capture path
(Source) to the destination directory; a progress
bar displays.

1000010 dat . P~
+1000070.tif
1000011.dat
1000011 uf
+1000012.dat
1000012 uf
+1000013.dat
51000013 uf
+1000014.dat ¥

Source: Destination:
|c:\nglam Files\Tma C:\Program Files\1ma
Progress bar |
Start Transfer Cancel

FTP or Other Depending on the program and the parameters
you set, 1Scan displays either a DOS shell or a
windows program.

Tmage Software Inc.
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1Scan general procedures

Navigating 1Scan

The 1Scan interface presents differently depending on whether
1Scan is connecting to an image server 8.1 or an earlier version.
The primary differences between these interfaces are how image
are transferred. In general, the procedures for accessing all other
1Scan procedures remain the same.

Note: Check Tool Scan configuration settings before scanning
to make sure that all settings are as you expect them to be.

The process for configuring 1Scan, scanning and transferring
images typically involves the following Steps:

-_—

Configure the Scan Session (discussed on page 30)
Configure Scanner settings (discussed on page 62)
Select Device (discussed on page 70)
Select scanning mode (discussed on page 73)
Regular scan versus Preindexing
Single Scan versus Continuous Scan
Load document(s) in Scanner (discussed on page)
Scan Images (discussed on page 80)
Review Images (discussed on page80)
Transfer Images (discussed on page 29)
Exit 1Scan (discussed on page 29)

>N

0V N

The following general procedures discuss in detail each of these
steps. The following procedures are common to all 1Scan
configurations except where noted:

1Scan screens may be navigated using the pull down menu,
keyboard commands (mnemonics and function keys), and/or the
1Scan tool bar.
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A mnemonic is any letter that is underlined. To access main
menu options using mnemonics, hold down the Alt key and type
the item’s mnemonic; to access a submenu option, simply type
the mnemonic. For example, to access Settings, hold down the
Alt key and type f to display the File menu, release the Alt key
and then typess.

&[=M Scanner Server Wiew Batch Options Pre-Indexing Help

Transfer Images... F11

Settings...

Exit

The following function keys are also available:

F1 Main Help F7  View/Fitin
Index Window
F2  Scan F8  Pre-Index by
Document
F3  Re-Scan F9  Continuous Pre-
Indexing
F4  Stop Batch F11  Transfer Images
Processing
F5  Scanner Setup F12 Options/Add
Page

F6 View / Actual

Design: view window

The 1Scan view window displays an electronic image exactly as it
is scanned; for example, if the image was scanned upside down,
it displays upside down. 1Scan makes magnification or rotation
modifications to the image, which displays in the view window,
not to the stored image.

Note: The resolution at which you view the image is a function
of the monitor on which you view it, not the 1Scan software.

The 1Scan window displays eight menu options: File, Scanner,
Server, View, Batch, Options, Pre-Indexing, and Help. Some
submenu items are mapped to a function key, which may be
used instead of the mnemonic key or mouse to activate the item.

Tmage Software Inc.
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The bottom of the view window displays a status bar which
mirrors the:

e 1Scan status

e Scanning mode

Batch code name
Location within the batch
Image counter

File Scanner Server Wiew Queue Options Pre-Indexing Help

1A | B 2 |25

i
L
L

[ | |

| Hleady | Sir'lgle Scan | nnlilne\AI7[:1 l]{ | (1]
) ) / Location w ithin
Online/Offline status the batch
1Scan Status
Queue-Batch code name

i I nter
Scanning mode mage counte

File submenu choices are Transfer Images, Settings, and Exit.
Settings... displays the current Tool Scan settings in read-only
mode.

=0 Scanner Server Wiew Batch  OQphions  Pre-Indexing  Help

Transfer Images... Fl1l
Settings...

Exit
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Scanner submenu choices are Scan, Re-scan, Continuous Scan,
Scanner Settings..., Reset Engine, and Select Scanner.

L OX

Eile BEERRES Server  Wiew Batch  Options  Pre-Indexing  Help

g_gﬁ Continuous Scan
[y

Scanner Settings... FS

Reset Engine
‘ Select Scanner, ..
=il

Server submenu choices are Scanner Device, Disk Device Start
Batch Processing, and Stop Batch Processing.

Bile Scanner BEEEEES Wiew Batch  Opbions  Pre-Indexing  Help

5 v Scanner Device
] Disk Device
|£-|
==

View submenu choices are Actual [1:1], Fit in Window, and
Display Settings....

File Scanner Server BUELNS Batch  Options  Pre-Indexing  Help

5 Actual (1:1) F&
w Fit in Window F7
Display Settings. ..
ad

Batch submenu choices are New Batch, First Image, Previous
Image, Next Image, Last Image, Go to Image ..., Cut Image, Paste
Image, Delete Page, Delete Image, Delete Batch.

15can s1000132. tif

File Scanner Server Wiew NaEla¥ Options  Pre-Indexing Help

Teva Batch Chrl+B

Eirst Image

Previous Image

Mext Image

Last Irnage

Goto Image ... Chrl+a

Zuk Image Chrl4n

T 2 iR 2R |2

L
L
L

Delete Image Del

12

Delete Batch

=
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Options submenu choices are Add Comment, Auto Batch
Transfer, Reset Counter when Changing Batch, Add Page,
Imprint Page, Black Border Properties..., Deskew Properties...,
Despeckle Properties..., Deshade Properties..., Line Removal
Properties..., Bar Code Properties..., Patch Code Properties...,
Log Patch Code Reads, and Save Settings on Exit.

15can s1000132.tif;

File Scanner Server View Bakch Weldd&y =8 Pre-Indexing Help

Add Comment...
v Auto Bakch Transfer
Reset Counker when Changing Batch
Add Page Fiz

Black Border Properties. ..
Deskew Properties. .,
Despeckle Properties, .
Deshade Properties. ..
Line Removal Properties., ..

TH = [ R &

L
L
L

Bar Code Properties, .,
Patch Code Properties. ..
Log Pakch Code Reads

| |ele

v Save Settings on Exit

Note: When 1Scan is connecting to an image server version of
8.1 or later the Auto Batch Transfer option is not required.
Therefore, the Auto Batch Transfer option is not listed in the
options menu

Pre-Indexing submenu choices are by Document and
Continuous Pre-Indexing.

15can s1000132. tif

File Scanmer Server Yiew Batch  Options

g

15can s10001 32.tif;

Fil=  3canner Server Wiew Batch  Options  Pre-Indexing BsEE

Main Index  F1
About 15CAM

.
£

(=
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About 1Scan... provides release and version information.

15can

&HH Releaze 10.2.1

Image Capture and Indexing system
Copyright 2005 1mage Software, Inc

1] More

When you click on More, the About... window displays the
Engines and Module Revisions available for your software
release and installation.

273138 Kofax Image Products IMGCTLS

=:1 Copyright = 1393-2001 V36718

Sources todule Revisions

Fuijitzu M30910C with SRS with AIPE KFDLG.OLL - Yer. 367 »
_ Scan AP - Ver 367

Primary Accelerator. Condaor KPR Clipping ¥.ofax Process Module DLL
Type: [C5'W C:\Program FileshKofax\mgetlz\bin\CLIFT03
IRO: na V3BT 18
1/0 Address: nia 1234567550
temany: n/a Rotation Kofaw Process Module DLL b

Design: tool bar

In addition to the view window, 1Scan displays a tool bar with
eight buttons. Those options that are currently active are
highlighted and as the cursor passes over a tool bar button, the
name of the tool displays in the status bar at the bottom of the
1Scan view window.

The following is a list and a brief description of each of the tool
bar buttons and their functions:

£54  Scan Activates scanning

GJQ Re-Scan Replaces last scanned image with current
' scanned image (single scan mode only).

% Settings Displays the Scanner properties dialog box.

% AddPage Adds the scanned image to the currently

Tmage Software Inc.
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ad

£

displayed image or (single scan mode only).

Pre- Displays the Pre-Indexing by Document
Indexing dialog box (single scan mode only).
Add- Displays the Comments dialog box. This

Comment allows comments to be added to the image.
These comments are a part of the indexing
information for this image and can be
reviewed, edited or deleted after indexing.

All Adjusts the size of the image to fit the
display area.

Scan Source Toggles between the scan sources available
to your scanner: ADF, Flatbed, or Panel. If
only one source is available for your scanner
then this button will be grayed out.

Note: When Flatbed is enable the
continuous scan option on the pull down
menu is grayed out.

Configuring your scan session

1Scan offers a variety of configuration options designed to both

faci

litate the scanning process and meet your company’s specific

needs. 1Scan permits the scanning operator to

Set up the scanner for paper size, source, and destination;
scan mode; scanning DPI, contrast, and intensity; orientation,
picking rectangle size; and other parameters specific to each
type of scanner.

Enhance, rotate, and magnify an image for viewing.

Deskew, despeckle, deshade, and remove lines from scanned
images in order to enhance and clean up the images.
Populate the image record with a document type and up to
three index keys to an image.

Enable and configure bar code characteristics.

Enable and configure patch code characteristics.

Proof each image within a batch.

Many of these options are found in the main menu under

Sca

nner | Scanner Settings and under Options. Below is a list of

specific scanner options.

Re-size the 1Scan view window
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1Scan User Guide, ©2019 36



1Scan general procedures

Set up scan session for duplex mode scanning (See “To
configuring duplex scanning” on page 40)

Set Auto Batch Transfer option (See “To enable/disable Auto
Batch Transfer” on page 45)

Activate the Imprint Page option (See “To activate/deactivate
Imprint Page” on page 45)

Set up Black Border Removal (See “To set up black border
removal” on page 46)

Set up deskewing correction (See To set up deskewing
correction on page 47)

Set up despeckling correction (See “To set up despeckling
correction” on page 48)

Set up deshading correction (See “To set up deshading
correction” on page 48)

Set up line removal (See “To set up line removal” on page 50)

Enable and configure bar coding (See “To enable and
configure bar code characteristics” on page 51)

Enable and configure patch coding (See “To enable patch
code logging” on page 57)

Enable patch code logging. (See “To enable patch code
logging” on page 61)9 To enter a batch code

If the Batch Code function is enabled, the Batch Name dialog
box displays.

15can - Batch

B atch Mame: |

k. Cancel

. Type a New Batch Code. You may use alpha or numeric

characters; do not use special characters such as stars (*¥),
slashes (/\), ampersands (&), dollar signs ($), or pound signs
(#). Also, do not put spaces between characters.

Caution: When connecting to image server version 8.0a or
earlier, do not use the same batch code simultaneously from
multiple scanners. The BUILD.BATCH process will be
compromised.
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3. (lick on OK to accept your entry. Click on Cancel to exit
1Scan.

¢ To alter the magnification of an image

1Scan makes magnification modifications to the image, which
appears in the view window, not to the stored image. Use this
feature as needed to inspect image content.

Do one of the following:

e From the View menu option, select Actual [1:1] or Fitin
Window.

This menu option Does this

Actual [1:1] Displays the document image at 100%
magnification in the window. The entire
document will not be visible.
Recommended for quality checking.

Fitin Window Adjusts both vertical and horizontal
dimensions to fit the image into the
window.

e Zoom the page in or out.

Type To do this

I Zoom the current page in by x2
o) Zoom the current page out by x2

e Use the Rubber band zoom to magnify an area.

Rubber band zoom can be executed at any time.
Subsequent scanned documents will display the same
zoomed location until another view is selected.

To do this Do this

Magnify a rectangular area of a page. 1. Position the
mouse at one
corner of the
desired
rectangular area.

2. Depressand
hold the left
mouse button.

3. Dragthe mouse
to the opposite
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comer of the
desired
Image ldisplays] rectangular area.

4. Release the left

mouse button.*

to magnify

/ this area.
displays

*Pressing the right mouse button before releasing the left
mouse button terminates the operation with no zoom.

Click on OK to save your changes. Cancel exits the window
without saving your changes.

4 To rotate an image

All rotations begin from the image’s original display position; for
example, if an image displays upside down, rotate it 180° so that
it displays right side up. Remember, 1Scan makes rotation
modifications to the image, which appears in the view window,
not to the stored image.

1. From the View menu, select Display Settings. The Display
Settings window displays.

| Display Settings @

Rotation Attributes
+ 0 [ Scale-To-Gray
- 270 90 [ Horizontal Emphasis
~ 180 [ Wertical Emphasis
ok |

2. Do one of the following:

e Select0, 90, 180, or 270, and press Enter.

This rotation Does this

0 Returns the image to its original position
in the view window.

90 Rotates the image one-quarter of a turn
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to the right (90°) from its original
position.

180 Rotates the image one half of a turn to
the right (180°) from its original position.

270 Rotates the image three-quarters of a
turn to the right (270°) from its original
position.

3. Click on OK to save your changes. Cancel exits the window

without saving your changes.

To improve the appearance of an image in the view window

l‘ These settings change only the image as displayed in
1Scan. They do not change the stored image.

1.

From the View menu, select Display Settings. The Display
Settings window displays.

w| Display Settings @

Rotation Attributes
o0 [~ Scale-To-Gray

~ 270 90 [~ Hornizontal Emphasis
(~ 180 [” ¥ertical Emphasis

Select one or more of the following to darken the image
which appears in the view window:

e Select Scale-To-Gray.

e Select Horizontal Emphasis to enhance the horizontal
plane.

e Select Vertical Emphasis to enhance the vertical plane.

Click on OK to save your changes. Cancel exits the window

without saving your changes.

Note: If scanning in duplex mode, the display settings for
the front and back pages are adjusted separately. Complete
the above steps for improving the appearance of the image
for both the front and back pages.

To configuring duplex scanning

1Scan supports duplex scanning. When in duplex scan mode,
both left and right pages display in the 1Scan display window.
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This facilitates proofing of double-sided document images by
allowing the user to view both sides of a scanned page.

15can b1000141.tif b1000142. tif

File Scanner Server Yiew Batch Options Pre-Indexing Help
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When scanning in duplex mode both front and back pages are
treated as a pair. This means that rescanning an image in duplex
mode will rescan both front and back pages. An image that is
cut and pasted in duplex mode will cut and paste both front and
back pages.

Individual pages scanned in duplex mode may be removed from
the scanned batch by one of the following methods:

e Configure Back Page Delete (See “To configure back page
delete” on page 42)

e Configure Front Page Delete (See “To configure front page
delete” on page 44)

e Use Delete Page option from Batch menu. (See “To delete
images in a batch” on page 84.)
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Complete the following steps to configure 1Scan for duplex

scanning:

1. Click Scanner > Scanner Settings. The Scanner Properties
screen displays.

Scanner, Properties - Fujitsu M309xDC

General

Source:
Drestination:
Besolution [DPI):

FPaper Size:
Orientation:
Tirneaut

Scan Start [secs]:

]

Jeor ]
I
ET— -

Letter Size -

[Foat <]
1a E

Cancel |

Color Mode

|Bllack & White

Other
=
B
I

Sides

% Single-sided
" Duplex

Options... | Advanced...

[~

2. Select Duplex and click OK.

Scanner, Properties - Fujitsu M309xDC

General

Source:
Drestination:
BRezolution [DP1);

Paper Size:
Orientation:
Tirmeout

Scah Start [zecs):

=]

eor
n

200 -

Latter Size hd

10 E

Cancel |

Caolor Made

|Black & wihite

Other

v

r

I
Sides

" Single-sided

Ophions... | Advanced...

=

1Scan now displays all scanned images in duplex mode.

To configure back page delete

When scanning in duplex mode some users may prefer to throw
out blank images that may occur while scanning a batch of
images. Typically, these blank images will be the backside of a
single page document or a blank page before the start of a new
section. 1Scan provides the option of throwing out these
intermittent blank pages without throwing out valid images as

well.

Complete the following steps to configure 1Scan to throw out
empty back pages:

1. Click Scanner > Scanner Settings. The Scanner Properties
screen displays.
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Click the Options button. The Source Properties screen

displays.

Source Properties
Front Picking Rectangle

[io0
~
~ =
L=
=
Front Ratation
+ 0 90 ¢ 180 ¢ 270

Frant Delete Blank Page Threshaold

™ Threshald (bytes]:
Optionz
B
QK |

Frescan [cache):

Back Picking Rectangle

Enahled :
e
~ =

=]
=]
Back Rotation
0 " 80 180 O 270

Back Delete Blank Fage Threshold

[ Threshold [bytes):
Fage Timeout [zecs): 15 E

Cancel |

Check the Threshold (bytes) box under “Back Delete Page
Threshold.” The Threshold (bytes) field becomes active.

Source Properties
Front Picking Rectangle

Enabled -
€
~ =

L=
=
Front Ratation
+ 0 90 ¢ 180 ¢ 270

Frant Delete Blank Page Threshaold

™ Threshald (bytes]:
Optionz
B
QK |

Frescan [cache):

Back Picking Rectangle

Enahled :
e
~ =

=]
=]
Back Rotation
0 " 80 180 O 270

Back Delete Blank Fage Threshold

¥ Threshold (bytes): 2200
Fage Timeout [zecs): 15 E

Cancel |

Enter a file size value (in bytes) between 0 and 65000.

Note: Blank images vary in file sizes anywhere from 1000
bytes (1k to 3000 bytes (3k) depending on the stock of paper
used, on how clean the actual image is at scan time and the
resolution used to scan the images. To ensure that only the
desired images will be thrown out, scan one to three sample
blank images and one to three images with a minimal
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amount of content. Compare the file sizes of these scanned
sample images and pick a number that is just higher than the
file sizes of the sample blank images, but less than the file
sizes of the image containing minimal content.

5. Click OK to close the Source Properties dialog box.
6. Click OK to close the Scanner Properties window.

1Scan is now configured to delete back pages.

To configure front page delete

Complete the following steps to configure 1Scan to delete blank
front pages:

1. Click Scanner > Scanner Settings. The Scanner Properties
screen displays.

2. Click the Options button. The Source Properties screen
displays.

Source Properties

Front Picking Rectangle Back Picking Rectangle
[~ Enabled
i i £
~ = ~ ]
l ™ B
£
o —H
=

Front Ratation Back Rotation

« 0 " 80 ¢ 180 ¢ 270 « 0 " 80 180 O 270

Frant Delete Blank Page Threshaold Back Delete Blank Fage Threshold
¥ Threshold (bytes]: 12200 [ Threshold [bytes):
Optionz

Frescan [cache): 3 E Fage Timeout [zecs): 15 E
ak. | Cancel |

3. Check the Threshold (bytes) box under “Front Delete Page
Threshold.” The Threshold (bytes) field becomes active.

4. Enter afile size value (in bytes) between 0 and 65000. Click
OK. 1Scan is now configured to delete front pages.

Note: Blank images vary in file sizes anywhere from 1000
bytes (1k to 3000 bytes (3k) depending on the stock of paper
used, on how clean the actual image is at scan time and the
resolution used to scan the images. To ensure that only the
desired images will be thrown out, scan one to three sample
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blank images and one to three images with a minimal
amount of content. Compare the file sizes of these scanned
sample images and pick a number that is just higher than the
file sizes of the sample blank images, but less than the file
sizes of the image containing minimal content.

5. Click OK to close the Source Properties dialog box.
6. Click OK to close the Scanner Properties window.

1Scan is now configured to delete front pages.

L 2 To enable/disable Auto Batch Transfer
(Legacy interface only)

Batch transfer refers to the process of transferring image and
data files from the batch directory to the capture path. Some
configurations may require the user to respond to two sets of
image transfer confirmation messages. In these instances users
may want to disable the batch transfer confirmation messages
when they have completed scanning and reviewing a batch.

Enabling Auto Batch Transfer will automatically transfer batch
images from the batch directory to the capture path when the
user does one of the following:

e C(licks File > Transfer Images
e C(licks Batch > New Batch
e Exits 1Scan.

To enable Auto  Select Auto Batch Transfer from the Options
Batch Transfer menu by clicking it to display a check mark.

To disable Auto  Select Auto Batch Transfer from the Options
Batch Transfer menu by clicking it to remove the check
mark.

L 4 To activate/deactivate Imprint Page

Note: Imprinting must be enabled in Tool Scan in order to
activate the Imprint Page option in 1Scan. This feature is only
available on Imprint capable scanners.

Toturnon Select Imprint Page from the Options menu
Imprint Page by clicking it to display a check mark.

To turn off Select Imprint Page from the Options menu
Imprint Page by clicking it to remove the check mark.
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*

To set up black border removal

Black borders can appear on images as a result of capturing the
images on scanners with black belts or drums, such as the Kodak
ImageLink or Bell+Howell Copiscan Il scanners. These scanners
display black borders if the paper being scanned is smaller than
the defined scanned region. To compensate for this, a black
border removal option is provided in 1Scan.

Note: Black Border removal is not an issue for many newer
scanners since these scanners do not produce images with black
borders.

To enable black border removal
1. Click Options > Black Border Properties. The Black Border

Properties dialog box displays.

Black Border. Properties

=
o]

Click the Enable check box.

Cancel |

Black Border Properties
Remowal

[ Crop

Wwhite Moise Gap [piselz]. |0 E
(] |

Select the desired value between 0 and 10 for white noise
gap.

Cancel |

Note: The “White Noise Gap” setting controls how much
noise is tolerated before the noise is determined to be a part
of a black border and is thus removed. If black borders still
display, then adjust the white noise gap value accordingly.
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To set up deskewing correction

Deskew is the automatic correction of image alignment as a
result of the scan process. Enable deskew detection and
correction option only if documents might be fed through the
scanner in a slanted fashion. When these options are enabled,
1Scan corrects the image display by realigning those images
which deviate less than 12 degrees from the perpendicular.

For more detailed help, press F1 while in the Deskew Properties
window.

1. Select Deskew Properties from Options to display the
Deskew Properties window.

Deskew Properties

D etection Correction
¥ Enable ¥ Enable
) — Minimum Angle [degrees): |EI.EI E
[~ b adirum Angle [deagreesl: 12,0 E
] | Cancel |

2. Enable both Detection and Correction in the Deskew
Properties window.

3. Set the minimum and maximum angles from the
perpendicular that are to be deskewed. The minimum angle
is 0° and the maximum angle is 12°; an image with a skew
greater that 12° will not be corrected.

4. Click on OKto accept the changes and return to the Main

Menu or click on Cancel to register no change.
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To set up despeckling correction

Speckles are defined as groups of black pixels surrounded by
white pixels (or white pixels surrounded by black pixels). Enable
removal to eliminate unwanted speckles that satisfy the height
and width characteristics that you define. Use caution when
using this option: if the height and width properties are set too
high, 1Scan will remove portions of your image that you want to
keep, such as periods and commas.

For more detailed help, press F1 while in the Despeckle
Properties window.

1. Select Despeckle Properties from Options to display the
Despeckle Properties window.

Despeckle Properties

R ernoval

Height [pixelz] |4 E
Wwhidth [pimelz]: |4 E

ak | Cancel |

2. Enable Removal in the Despeckle Properties window.

3. Define the maximum height and width in pixels of the
speckles you want to remove. The default setting, four pixels
high by four pixels wide, is a good definition to begin with
when you scan a test image.

4. Click on OKto accept the changes and return to the Main
Menu or click on Cancel to register no change.

To set up deshading correction

Image shade is defined as shaded areas on an image made up of
a pattern of black speckles. Enable the deshade detection and
removal option if you wish to remove large shaded areas from
your image while preserving the text inside the shaded areas.
The deshade property removes shading that satisfies the height
and width characteristics that you define. Because shaded areas
are not usually uniform in size or shape, you can define a
compensation value in order to adjust for the variance.
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For more detailed help, press F1 while in the Deshade Properties
window.

1.

Select Deshade Properties from Options to display the
Deshade Properties window.

Deshade Properties

Detection

Rermowval
| Enable
Mirirnurn ‘Width of Area [pikels): 100 o
Minirum Height af Area [piselz): 20 %
M aximum Speckle \Width [pikelz]: 12 %
M axirnurn Speckle Height [pisels): 12 %
Speckle Width Compensation [pielz]: 0 %
Speckle Height Compenzation [pixels]: 0 %

(] 4 | Cancel |

Enable both Detection and Removal in the Deshade
Properties window.

Set the minimum width and height, in pixels, of the area from
which shading is to be removed. Define these values as large
as possible without making the values larger than the
smallest shaded area on your document.

Define the maximum width and height, in pixels, of the
speckles that you want to remove from the shaded area. The
default setting, four pixels high by four pixels wide, is a good
definition to begin with when you scan a test image.

Define the width and height compensation. Leave these
properties at their default value of “1” when you begin.

Click on OK to accept the changes and return to the Main
Menu or click on Cancel to register no change.
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To set up line removal

Enable the horizontal and/or vertical line removal property when
your document has unnecessary lines that might increase the
size of the compressed image file. 1Scan can remove both
horizontal and vertical lines in the same scanning process.

For more detailed help, press F1 while in the Line Removal
Properties window.

1. Select Line Removal Properties from Options to display the
Line Removal Properties window.

Line Removal Properties

Horizontal Yertical

v Enable v Enable

Mirimum Length [pixels): ln— E Finimum Height [pixels]: ,n— E
b aximum Height [pixels): IEI_ E b aximum ‘wfidth [pixelz]: 'U_ E
tdarimurn Break. [pisels): IEI_ E td agirmurn Break. [pixels): ,D_ E
Edge Clean Factar [pixels): IEI— E Edge Clean Factar [pixels): ,D— E

Huarizontal Character Reconstuction Yertical Character Reconstruction
v Enable v e

binimum Bepair Height [pisels): I} E Minimum Reparr Height (pixels]: 0 E
M arimurn B epair \Width [pisxels]: 1] E t amirmurn B epair Width [pisels]: 0 E

] | Caticel |

2. Enable horizontal and/or vertical line removal.

3. Set the minimum length and maximum height of
unnecessary horizontal lines and the minimum height and
maximum width of unnecessary vertical lines.

4. Define the maximum break, or gap size allowed, to be

considered part of the line. Accept the default for your first
test scan.

5. Define the Edge Clean Factor, or noise on the edge of the
line. 1Scan will remove these speckles along with the line.
Accept the default for your first test scan.

6. Click on OK to accept the changes and return to the Main
Menu or click on Cancel to register no change.
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¢

To enable and configure bar code characteristics

Note: For additional information about the values entered in
the Bar Code Properties and their impact on the bar code
recognition accuracy rate and speed, customers who have
purchased the 1Scan bar code option are referred to

¢ ImageControls Manual
e Kofax Application Notes: Bar code Recognition

e 1MAGE Technical Bulletin: Bar code Recommendations

About bar codes

The following bar code components and their physical and
quality attributes are essential to the bar code configuration
process:

Components
Bar A single black element
Space The lighter element found between bars

Element Either a bar or a space
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Physical attributes

The physical properties of a bar code describe its dimensions
and characteristics; once correctly defined, these properties
remain the same and are independent of the manner in which
the image is scanned. Physical attributes are:

Type The format of the bar code; for example,
Codabar, Code 3 of 9, etc.

Bar width The physical width of the smallest element found
within the bar code; the larger elements are
calculated by applying the ratio value to this
width.

Ratio Either a 2:1 or 3:1 ratio between the smallest and
the largest element in a bar code; has meaning
when the bar code type is Code 3 of 9, 93,
Interleaved 2 of 5, and Codabar.

Length The smallest size bar code (in terms of

(minimum  characters) the bar code driver should return; if

characters  thelength is variable, set the value to 1.

in a bar

code)

Checksum  An additional character added to the bar code
that determines the integrity of the bar code
read; meaningful for Code 3 of 9 and Interleaved
2 of 5 only.

Quality attributes

Quality The unwanted noise surrounding the bar code,
such as speckles, and the quality of elements
within the bar code, such as jagged edges.

Height The distance between the top of a bar and the

bottom of a bar. 1Scan uses the height field to
determine the distance between probes that the
driver must use when searching for a bar code.
The height value can be adjusted to speed up
the bar code driver. To produce smaller probe
distances, decrease the height value. As the
probe distance becomes smaller, the driver slows
down but the read accuracy rate improves. As
the probe distance becomes greater, the driver
speeds up but the read accuracy declines.
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For more detailed help, press F1 while in the Bar Code Properties
window.

1.

Select Bar Code Properties... from Options to display the Bar

Code Properties window.

Bar Code Properties

F!ecq_gnition Interpret Bar Code
[ Leam &g Patch Code: |Mo patch code -
Bar Size Limnits
Height [in): 0.50 E Minirurn Characters In Bar Code: |0 E
Maximum Bar Codes Per Page: 1 E
K gl M agimumn Bar Codes Per Line: 1 E
[~ 2To1 Ratio
Search Direction Guality Checkeum
W o [ a0l 180 270 Good - [” Enable

Bar Code Algorithm

{+ Standard Bar Codes " Enhanced Bar Codes

Type
Ayailable; In Usze;
Codabar ” Code 39 (30 9)
Cods 125
Code 33
E&M 4
Interleaved 2 of & <Hemovs
Litear 2 of & b
ak. | Cancel |

Enable Recognition in the Bar Code Properties window.

Do not enable Learn when doing bar code reading; see “To
use Learn Recognition” on page 56.

Enter the Bar Size. Set the following:

Height

Width

Set the value equal to the actual height of
the bar code, then raise or lower this
value in order to adjust the probe
distance beyond the range provided by
the quality value; for multiple bar codes,
use the height of the smallest bar code.

For multiple bar codes, the Any Width
attribute is automatically set when
multiple bar codes are listed in Type In
Use. For a single bar code, set the Bar Size
Width to that which was returned to you
by Learn Mode.
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2 To 1 Ratio The default is 3:1. Do not check this box
unless Learn mode set the attribute to
(2:1).

4. Enter the limits of the bar code.

Minimum If you know the smallest value, set the field
Charactersin  to that value; if you do not know the
Bar Code smallest value, set the field to 1.

Maximum Bar Set to the likely number of bar codes per

Codes Per image; this value should be as small as

Page possible so that the driver can stop
searching as soon as the correct number
of codes is found.

Maximum Bar Set to 1 or set to the actual number of bar

Codes Per codes on the same probe axis. This

Line attribute tells the bar code driver to
continue probing until the edge of the
image is encountered or the number of
bar codes set in Maximum Bar Codes Per
Line has been read.

5. Enter the search direction of the driver.

The search direction governs how the bar code driver
searches for bar codes (for a horizontal bar code at 0 degrees
and 180 degrees; for a vertical bar code at 90 degrees and
270 degrees). Set only those orientations that are necessary
to obtain a read.

Note: These values are not set by the Learn setting; they
must be identified by a user. Use the human readable
characters below your bar code as your clue as to which
orientations you should use. In the examples below, the
probe direction is depicted by an arrow.

Oo
B NN |
—>
180
S | I | | o
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90° 270°

[ 1N

6. Enter the quality of the bar code.

Select normal for most bar codes. Select poor for bar codes
with obviously missing elements and poor delineation; select
good for bar codes with excellent delineation.

Note: Setting bar code quality to “high” allows the scanner
to read bar codes faster. Setting this to “poor” will cause the
scanner to read slower. This will reduce the scanner’s overall
scan speed performance.

Enable Checksum if necessary.

Checksum (for Code 3 of 9 and Interleaved 2 of 5 only)

If you do not know if the checksum exists or not, turn off the
attribute; if 1Scan finds a checksum character, it returns it as
extra data.

Enter the type of bar code or codes you will be scanning.

To add a bar code type, select the type or types of bar codes
listed in Available and click Add. The selected name(s) move
to the In Use list.

To remove a bar code type, select the bar code type from the
In Use display and click Remove. The selected name(s) move
to the Available list.

Please note when attempting multiple bar code readings
with multiple types active:

e Code 2/5 cannot be distinguished from Code 2/5
interleaved.

e Code 2/5 can sometimes read Code 39.

e EANisasuperset of UPCA.
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¢ Postnet should be done stand-alone.
9. Press Enter or click on OK.

L 2 To use Learn Recognition

Use the bar code learn feature to determine the most
appropriate property values associated with bar codes on an
image. If the correct bar code type is in use, and Learn is
enabled, then the learn action automatically populates the Bar
Code Properties window with the bar height, bar width, ratio (if
2:1), and quality of the bar code.

Note: Learn will not return the name of the bar codes in use.
After you have run the learn action several times, it can be
disabled and the values it returns can be used when scanning
documents with like bar codes.

Learn will not work on skewed bar codes or on more than one
bar code on a page.

For more detailed help, press F1 while in the Bar Code Properties
window.

1. Do the following:
e Select the type of bar code that you are scanning and
display it in the In Use window. If you do not know the type

of bar code you are scanning, place a probable bar code
type in the In Use window.

e Select the search direction attribute that matches the
orientation of the bar code you are scanning. If you
suspect that the bar code is skewed, enable the
Deskewing function after you enable Learn Recognition
and before you scan.

e Set the height value to the lowest value available.
e Set the width value to the lowest value available.
e Set the quality to normal.
e Press Enter or click on OK.

2. Enable Learn in the Bar Code Properties window.

3. Scan adocument. Look in the scanned image’s .dat file for a
*BC entry to confirm that the bar code was read. Do the
following:
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e If the bar code was not read, continue to change the Type
In Use until a read is obtained.

¢ |If the bar code was read, access the Bar Code Properties
screen and make note of the values returned. Scan
several times more using the same document or different
documents with the same type of bar code. This activity is
especially important for determining variations in the
width: while the bar code driver allows for some overlap,
the width value should be as accurate as possible to
insure the best read accuracy rates.

4. Disable Learn in the Bar Code Properties window; the values
obtained during your last scan using the learn action are
saved.

L 4 To enable and configure patch coding
About patch codes

A patch code is a distinct pattern of horizontal black bars and
spaces used to maximize scanner throughput and to minimize
operator intervention.

All patch codes are made up of narrow and wide bars:

e The entire patch code must be 0.80 inch in height.

e The entire patch code should be at least 2.0 inches in width.
e The narrow bars must be 0.08 inch in height.

e The wide bars must be 0.20 inch in height.

1Scan can identify two distinct types of patch codes when
processing images from the scanner.

Note: Instead of creating your own patch codes, you may obtain
examples of patch codes from the TMAGE document,
patchcode.doc, created in Microsoft Word 97. Copy the types
you need and stretch each horizontally at least 2.0 inches. Do not
adjust the height of the patch code or patch code recognition
will be compromised.
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To implement patch coding, place a single patch code on the
leading edge of a separator sheet; place a separator sheet
between a series of documents that may be of different types,
sizes, or print quality.

Patch code and
associated bar code
on separator sheet

Patch code and
associated bar code
on separator sheet

Patch code and
associated bar code
on separator sheet

While the use of patch codes might require more time in
document preparation, time will be recovered in faster scanner
throughput and in reduced operator intervention and indexing
requirements.

1Scan and patch codes

1Scan reads a patch code before it does any other image
processing. It can identify two types of patch codes: |, Il.

A Patch Tells 1Scan to do this:
Code of this

type:

I Read the bar codes on this page. Include
persistent data elements in the .dat file of only the
page scanned immediately after the patch code
separator sheet; do not include persistent data in
the .dat file of pages scanned beyond this page.

I Read the bar codes on this page. Include
persistent data elements in the .dat files of all
pages scanned following this patch code separator
sheet.

To be detected, a patch code must be positioned correctly on
the separator page.
e It must be placed horizontally.
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e It must be located at least .20 inches from the leading edge
of the patch code sheet.

e It must not extend beyond 3.75 inches from the leading edge
of the patch code sheet.

e For duplex scanning operations, it must be placed only on
the front side of a patch code sheet.

As of release 8.1.1, 1Scan supports the use of patch codes | and Il
while “batch processing images from disk.” To utilize this
feature, Patch Code Sheets must be pre-scanned (with patch
code recognition turned off) along with the rest of the images to
be processed in batch processing from disk.

About bar codes associated with patch codes

Bar codes may be present on any Patch Code separator sheet.
They are used to change “persistent” data elements.

Note: To ensure maximum scanner throughput, TMAGE

recommends that all bar codes on a separator page be

e The same type.

e Setto “any width.” (a bar size setting on the Bar Code
Properties dialog box)

e Atleast 1/2 inch (.5) in height.

For use with patch codes, each bar code typically contains a
code identifier followed by a hyphen and then the code value;
for example: DATSTRING-123456.

<code identifier>-<code value>

Valid settings, functions, and persistent data elements follow:

Functions
Code identifier Code Value Action
CLEARDATA NONE Clears the “persistent
(or “CD") data entries: Type,
Datstring and Workflow
MULTIPAGE START Defines a multi-page
(or “MP”) document; all pages

except the first have a
*A entry inserted in their
.dat file.
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MULTIPAGE STOP Defines the end page of

(or “MP”) a multi-page document.
Cancels the previous
MULTIPAGE START
instruction.

BATCHCODE <New Batch Changes current batch

(or “BCODE") Code> code. All imagesin
batch will have a *B
followed by the new
batch code.

OPERATOR <New Operator Changes the current

(or “OP”) Code> operator code. All

images will have a *O
followed by the new
operator code.

“Persistent” data
Code identifier Code Value Action
TYPE <PCKey Code> Places a*l entryin the

.datfile.

Warning: When preparing patch code sheet that define type
codes, be sure the scanner operator has privileges to the scan
to those type codes. If 1Scan detects a type code that the
scanner operator does not have privileges to scan to the scan
operation will stop and display the message "You are not
authorized to apply type code: <###>" No further scanned
images can be saved until a valid patch code sheet is used or
until 1Scan is restarted.

WORKFLOW <Workflow Places a *WF entry in the

(or “WF") name> .dat file (requires API
integration)

DATSTRING <Any data Places a *DS entry in the

(or “DS”) string> .dat file (requires API

integration)

For more detailed help, press F1 while in the Patch Code
Properties window. Use the Search function to find Patch...

1. Enable Bar code Detection.

2. Select Patch code Properties... from Options to display the
Patch Code Properties window.
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Patch Code Properties

..........................................

[ Enable Detechor

L F et

o]

Left Offzet To Center of
Patch Cade [in]:

Cancel |

LIRS

3. Enable detection in the Patch Code Properties window.

4. Set the Offset to Center property and press Enter or click on

OK.

The value may be set between 0 and the maximum page
width in inches; we recommend however, that it be set to a
value no greater than that which defines a point that falls
near the center of the patch code. This value allows the
detection feature to quickly locate the patch code on the

page.
A value of 0 specifies that the detection feature will search

anywhere in a horizontal direction from the left edge of the
page.

Patch Code Properties

......................................... LR ElE To Barior
Patch Cade fin): 200 E

v Enable Detectiort
] |

Enable “Log Patch Code Log Reads” Set this flag to enable
Patch code logging. When enabled all patch code reads will
be noted in a file called patchcode.log. This file will be
written the 1Scan home directory (c:\\Program Files\1mage
Software\1Scan)

Cancel |

To enable patch code logging

Patch code logging is used to verify that patch codes and bar
codes are being read. When enabled, all patch code reads will
be noted in a file called patchcode.log. This file will be written
the 1Scan home directory (c:\Program Files\1mage

Software\1Scan). The following is a sample of a patch code log

file:
Patch 2
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CLEARDATA
MP-STOP
MP-START
TYPE-407
Patch 2
CLEARDATA
MP-STOP
MP-START
TYPE-408
Patch 2
CLEARDATA
MP-STOP
MP-START
TYPE-409

Patch code logging is a debugging tool and should only be
enabled when needed. If patch code logging is left enabled for
long periods of time the patch code log file will grow large and
consume disk space. This may impede the workstation's
performance.

Click Options > Log Patch Code Reads to enable patch code
logging:

15can s1000132.tif

File Scanmer Serwer View Babch Beldilyt8 Pre-Indexing Help

Add Comment. .
w Auto Bakch Transfer
Reset Counter when Changing Batch
Add Page Fiz

Black Border Properties. ..
Deskew Propertigs. ..
Despeckle Properties. ..
Deshade Properties, ..
Line Remowal Properties. .,

TH = 36 22 e

L
L
L

Bar Code Properties, .,
Patch Code Properties, .,
\ Log Patch Code Reads

v Save Settings on Exit

L lele

Set up your scanner

l‘ When you exit Scanner Properties, 1Scan saves the
parameters for the current 1Scan session. When 1Scan is closed
the Scanner Properties settings are saved in the 1Scan.ini file.
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This file is located in the directory where the 1Scan.exe file is
located (c:\Program Files\1Scan).

To set up your scanner

1.

Select Scanner Properties from the Scanner menu. 1Scan
displays the name of your scanner in the Scanner Properties
title bar.

Note: Each pull down menu displays only those parameter
values that are valid for your attached scanner. For instance,
in the following Scanner Properties example, the ADF source
and the Destination option are not active because the Fujitsu
M309xDC is a manual feed scanner that only scans to one
destination. .

Scanner Properties - Fujitsu M309xDC

General Color Mode
HOUEE | =) [Black & white |
Destination: | J

Other
Besolution (DP!): | EXDRM ~ -
Faper Size: |Letter Size j [
riertation; | J B
Tirneaut Sides
Scan Start [zecs]: 10 E ' Single-sided
" Duplex

k. | Cancel | Options. .. Advanced...

Select your desired scanning characteristics from those
scanner properties options that are highlighted in the groups
below. Remember, only those parameter values that are
valid for your attached scanner are active or displayed. This
means, for instance, that if your scanner can only scan at 200
DPI, then 200 DPI is the only Resolution option displayed.

Tmage Software Inc.

1Scan User Guide, ©2019 63



1Scan general procedures

General

Specifies input and output characteristics for scanning.

Source
Destinatio

n

Resolution

Paper Size

Orientatio
n

Timeout

Scan Start
(secs)

Color Mode

Designates the scan source: Flatbed, ADF
(Automatic Document Feed), Panel, or Manual.

Designates the output tray capabilities: Bin1 or
Bin2.

Designates resolution capabilities for the
current scanner: DPI 75, 100, 150, 200, 240,
300, 400, or 600.

Designates paper size capabilities for the
current scanner: A 0-5, B, Letter, B 0-6, Legal,
Coupon, Personal, or Business.

Specifies the format in which a page is to be
scanned; either standard format (8.5 x 11) or
wide format (11 x 8.5).

Portrait: Specifies tall (vertical) orientation

capability.

Landscape: Specifies wide (horizontal)
orientation capability.

L1

Specifies the number of seconds you are
allowed to load paper into the scanner after
starting a scan operation. The process will
report an out of paper error if the timer
expires before paper is added.

Important: Scan Start value must always be
less than Page Timeout value (defined on the
Scanner Properties dialog box).

The color mode setting specifies whether to scan in color or
in black and white. When scanning in color, all scanned
images will be saved to .jpg format. When scanning in black
and white, all scanned images will be saved in a .tif format.
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Other

Auto
Length
Detection

Continuou
s Sheet

Manual
Start

Sides

If Auto Length Detection is enabled when ADF
is selected as the Source, the stored image for
a document shorter than the Paper Size
setting will be only as long as the scanned
document.

Specifies a continuous scanning operation for
long documents (up to 32,767 scan lines).
When enabled, the paper width setting must
equal the width of the paper and the Auto
Detection Length must be disabled.

Not available

Specifies if a scanner is to capture one or two images at a time.

Single- Specifies a single-sided scanning operation.
sided
Duplex Specifies a two-sided (front and back)
scanning operation.
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3. Select Source Properties options by clicking on the Options
button. The Source Properties window displays. Choose
from those scanner properties options that are highlighted in
the groups below. Remember, only those parameter values
that are valid for your attached scanner are active or
displayed.

Frant Picking Rectangle

I Enabled r
R = | =
- =R ]
o A
E
o al
g
Front Rotation
t« 0 a0 ¢ 180 o 270 {+ i i T
Frant Delete Blank Page Threshaold
™ Threshald (bytes]: I
Optionz

Frescan [cache): 3 E Fage Timeout [zecs): 15 E
ak. | Cancel |

Front Picking Rectangle/ Back Picking Rectangle

Specifies the specific area of an image that you want clipped
and saved. The Top and Left properties define the starting
position or upper left corner of the picking rectangle; the
Width and Height define the size of the picking rectangle.

English (in)  Specifies the unit of measurement.

Pixels

Top Specifies the distance from the top edge of
the image.

Left Specifies the distance from the left edge of the
image.

Width Specifies the width of the rectangle.

Height Specifies the height of the rectangle.

Front Rotation/ Back Rotation

Specifies the rotation angle for scanning; the image is saved
in its rotated state.

0,90,180, Specifies, in degrees, the clockwise rotation of
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270 a scanned image from the direction it is
scanned.

Front Delete Blank Page Threshold/Back Delete Blank Page
Threshold

Allows you to set a value for determining if an image should
be deleted.

Front (Bytes) Specifies a threshold value for determining if
an image on the front side of a page should
be deleted.

Back (Bytes)  Specifies a threshold value for determining if
an image on the back side of a page should
be deleted.

Options
Specify scanning operation and memory configurations.

Important : For optimal throughput, tune Prescan
Cache to the highest number that your Kofax card will
tolerate. Typically, the more 1Scan features that you enable,
the higher you must set the cache.

Prescan Specifies the number of images (0-6 pages) to
Cache cache on the Kofax board; caching occurs only
(pages) if there is memory available on the board.

Caching defaults to 3 at installation.
Increase the Prescan Cache value when you
enable additional features such as deskewing,

etc.
Page Specifies the device timeout value in seconds
Timeout: (0-120). Use this setting to define the
(secs) maximum time allowed to completely process
a page.

Warning: Setting this value to 0 could cause
the system to hang indefinitely.

If processing is not completed in less than the
specified number of seconds, the process will
report a timeout error.

Important: Page Timeout value must always
be more than Scan Start value.
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4,

If the Advanced... button is active, click on it to display the
Advanced Setup dialog box.

The Advanced... button calls a scanner-specific dialog box.
Refer to your scanner’s user documentation for information
on the property options displayed in the dialog box.
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Image attributes

Specifies contrast and brightness capabilities for a small
number of scanners that do not display Advanced Setup

windows.

Contrast

Brightness

Specifies contrast capabilities; that is, the
degree of difference between the lightest and
darkest parts of an image: 1 specifies the least
amount of contrast and 8 specifies the most
amount of contrast; Auto adjusts the contrast
automatically, Panel specifies that the contrast
be controlled on the scanner; and Percent
specifies a percentage.

Specifies brightness capabilities; that is, the
ability to reflect light: 1 specifies the least
amount of brightness and 8 specifies the most
amount of brightness, Auto adjusts the
brightness automatically, Panel specifies the
brightness be controlled on the scanner, and
Percent specifies that a percentage of
brightness be specified.

5. When you are finished defining your scanner set up, click on
OK; the settings are saved.

To scan in color
1.

3.

Click Scanner > Scanner Setting from the main 1Scan screen.
The Scanner Properties screen displays.

Click the drop down button in the Color Mode field. A drop
down list of color mode setting displays.

Select "Color (true color)" and Click OK.

All images scanned in color will use a JPEG file format.

Note: Images scanned in color will typically produce larger file
sizes than images scanned in black and white. If disk spaceis a
concern then JPEG file sizes can be adjusted in one of two ways.
One is to increase the compression ratio that JPEG is using. See
the “To adjust JPEG Compression” for more information on page
70. The second is to decrease the scanner resolution. However,
decreasing scanner resolution will degrade the image quality.
This can be done from the Scanner Properties screen. See “To
adjust Scanning Resolution” on page 70 for more information.
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To adjust JPEG Compression

1.

4.
5.

Click Scanner > Select Scanner. .. The Select Scan Source
dialog box displays.

Click the Advanced button. .. The Advanced Source
Properties screen displays.

Enter a number between 1 and 100 in the JPEG Compression
Quality field.

Note: The higher the number the better image quality will
be provided and larger the file size. The lower the number
entered here the more image compression will be applied to
the file. Typically, a setting of 90 will produce a quality image
while maintaining smaller file sizes.

Click OK to close the Advanced Source Properties screen.

Click OK to close the Select Scan Source dialog box.

To adjust Scanning Resolution

1.

3.

Select a server device

Click Scanner > Scanner Settings from the main 1Scan
screen. The Scanner Properties screen displays.

Click the drop down button in the Resolution (DPI) field. A
drop down list of resolutions available to the scanner
displays (for example: 100, 200, 240, 300...).

Select the desired resolution and Click OK.

Your server device may be Scanner or Disk.

When you select Scanner, your imaging source is the default
scanner with KSM (Kofax Source Manager). Scanned images
are captured in the capture path (or in a subdirectory of the
capture path) defined in Tool Scan and are subject to the
image processes (such as despeckling, etc., and bar or patch
code reading) that you enabled in either Tool Scan and/or
1Scan.

Note: In Batch Mode, all scanned image files are stored in a
temporary subdirectory created in the capture path. This
temporary directory is named the same as the batch name
and will be deleted when all batch images are transferred.

When you select Disk, you may import images with image
processing (Kofax Hardware - Import from disk with image
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¢

processing) or without image processing (Kofax Hardware -
Import from disk without image processing). Images are
imported using the path you define as Input Path, and are
transferred (in a fashion similar to Filemove) using the path
you define as Output Path.

To configure a server device

1.

Display the Server menu and select a device.

File Scanner BEE@ETM Yiew Batch  Options Pre-Indexing Help

3 v Scanner Device
ol Disk Device

|

Do one of the following:
If you selected Scanner as a device

The Select Scan Source dialog box displays. This box will
only display if there is more than one source defined (See
1Scan Installation Manual for more information). If only one
source is defined then 1Scan will automatically load that
source and will not display the Select Scan source dialog box.

Select Scan Source

Source

| Fuiitsu M3091DC with SYRS with AIPE |

Lancel | Eroperties...| Adganced...|

If you selected Disk as a device

If more than one import from disk source is defined in the
KSM the Select Disk Source dialog box displays. Click the
drop down button (ﬂ) to display the drop down menu to
display a list of available sources. Make a selection and press
Enter or click OK. This enables “batch processing from disk.”

Available sources will typically be any of the following: Kofax
Software Import Source, Kofax Software — Import from disk
with image processing, and/or custom defined sources. The
actual source names displayed here will depend upon what
has been configured in the Kofax Source Manager (See 1Scan
Installation Manual for more information). If no disk source is
defined then the Disk Device option will be grayed out and
cannot be selected.
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Select Disk Source

If only one import from disk source is defined in the KSM.
The Select Disk Source dialog box will not display. The
existing import from disk source will be used.

Select Server > Start Batch Processing.

File Server R Options  Pre-Indexing  Help
Scanner Device

=i v Disk Device

9@ Stark Batch Processing  Chrl+a

szl

The Select Input and Output Path dialog box displays.
Browse the available drives and directories to define both
input and output paths.

Note: Images can be processed from a mapped network

drive.
ui| Select Input and Output Paths E]@
Input Path Output Path
| &2 b [WmagelT\IMAGE.SC..] | | | | S e |
b c
£ Program Files
Canm S 1mage Software
(27 mise =315can
[ no_batch
12
|h:'\in |ram Files\1mage Softwareb15cartoul
0K LCancel ‘

1Scan will look in the Input Path for any file with a .tif or .jpg
extension and import it to the Output Path.

Select Server > Stop Batch Processing to stop the process.

Note: As of 1Scan version 9.2.3 1Scan disk mode scanning
handles long file names. However, file names must adhere to
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a numeric format with a 1 or 2 digit alphanumeric prefix. For
example, f1234567890123456789.tif

Select a scanning mode and pre-indexing option

1Scan has two scanning modes that operate as a toggle: single
and continuous; when Continuous Scan is turned on, single scan
is turned off.

Single scanning mode displays an image in the view window
until another page is scanned. Continuous scanning mode
displays an image in the view window for a brief time and then
automatically displays the next image. The functions Add Page,
Add Comment, and Rescan are disabled when Continuous Scan
is selected.

4 To select a scanning mode

Do one of the following:

e For single scanning mode, a check mark does not display
before the Continuous Scan option in the Scanner menu.
Click the option to remove the check mark if it does appear.

Sl l= Server  View  Bakc

Single scan mode 4C>QDI'IUHLIDLIS Scan

Scanner Settings... FS

Reset Engine
Select Scannet. ..

For continuous scanning mode, begin by scanning one
document in single scan mode to ensure all settings are
correct, then click Continuous scan to display a check mark
before the option.

Sl l= Server  Wiew  Bakc

Scan Fz

Continuous scan 4@Dntinuuus Scan
mode

Scanner Sefttings... FS

Feset Engine
Select Scanner. ..
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L 4 To determine a pre-indexing option

If you do not select a Pre-indexing option, a scanned image is
not assigned an image type or index key code(s). 1Scan defaults
to this option when you exit 1Scan after pre-indexing.

1Scan has two pre-indexing options: by Document, or
Continuous Pre-Indexing. .. By Document is available in single
scan mode only; Continuous Pre-Indexing. . . is available in single
or continuous scan mode. Both pre-indexing options place a *I
or *l and *K(s) in the 1Scan .dat file.

Use the following table to determine the scanning modes and
pre-indexing options you wish to use. Some 1Scan
configuration combinations are mutually exclusive; for example,
pre-indexing by Document is not available when Continuous
scan is selected.

When you want to Set 1Scan to this

Scanning Mode Pre-indexing

option
Scan quickly without Continuous None
inspecting document Scan on
readability
Scan quickly without Continuous Continuous
inspecting document Scanon Pre-Indexing
readability
Attach the same type
code (and, optionally,
pre-index keys) to each
scanned image
Inspect document Continuous None

readability

Scan off (single
scan)

Inspect document
readability

Attach variable type
codes (and, optionally,
pre-index keys) to each
scanned image

Continuous
Scan off (single
scan)

by Document
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e Check document Continuous Continuous
readability Scan off (single | Pre-Indexing

e Attach variable type scan)

codes (and, optionally,
pre-index keys) to each
scanned image

Continuous Pre-Indexing

1Scan’s continuous pre-indexing feature enables 1Scan users to
index documents at scan time while in continuous scan mode.
This feature allows the user to enter Type and Key data once.
That information will then be applied to every image scanned.

1. Press F9 or select Continuous Pre-Indexing. . . from the Pre-
Indexing menu; the Continuous Pre-Indexing dialog box
displays. When Continuous Pre-Indexing. . . is selected, each
scanned image will be assigned the same image type code
and index key information.

Continuous Pre-Indexing
Type 001-999

’7‘ New | it |

Scan | | Cloze |

Caution: If you want all images scanned to have the same
type and keys, then use Continuous Scan / Continuous Pre-

Indexing.
If you want to change the index data then use Single Scan /

Continuous Pre-indexing

2. When the Continuous Pre-Indexing dialog box displays, do
one of the following:

e C(lick on New to clear all fields.

e Enter avalid Type between 1 and 999.
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Note: Some servers may have a type code list ranging
from 1 through 99. In this case, enter a valid two-digit
type code number.

Click List. The “Document Type List” dialog box displays.
Select a type and click on OK. The document type you
choose is active until you change it. To navigate the list
window, use the mouse or the up and down arrow keys

(T4).

& Document Type List @

on2 POD Proof of Delivery A
o003 CHE Check

oo4 COHTRACT Contract

111 5] CUSTIHV Customer Invoice

ooe SPRDSHT Spreadsheet

oo7 PO Purchase Order

008 MEMOD Memo bt

Note: The document types that actually display here
depends on the current user’s image type security
privileges. If you do not see a type code here that you
expect to see, contact your TMAGE system administrator
to verify that image type security has been set correctly.

The dialog box for your selected type code displays. If
any pre-index keys are associated with the code, they also
display. Press Tab to move from field to field. Click on
New to clear all fields.

Continuous Pre-Indexing

Type 001-999
0 0 7 MHew | List |

Purchase Order

Customer Name

D ate

Invoice Humber

Scan | Close

Tmage Software Inc.

1Scan User Guide, ©2019 76



1Scan general procedures

3. Review the image and populate the displayed pre-index

fields.

If you neglect to populate a pre-index field that matches a
required key, the following message displays.

Input Required §|

Pre-index field

name
! 'j Input is required for Cusfomer Mame field
.

If entered data does not conform to validation parameters,
an error message box, similar to the example below, displays.

Data Type Error

! E Dake must be in MM/DDYY oF MM-DO-YY Form
)

When you have populated all required fields, go to Step 9. If
you have completed the Continuous Pre-Indexing session
click on Close to cancel this Continuous Pre-Indexing session.

Note: The Rescan button is grayed out in Continuous Pre-
Indexing mode.

Pre-Index by document

1Scan’s pre-index by document feature enables 1Scan users to
index documents at scan time while in single scan mode.
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1.

Press F8 or select by Document from the Pre-Indexing
option; the Pre-Index by Document dialog box displays.

Pre-Index by Document
Type 001-999

o _ta |

Do one of the following:
e Click on New to clear all fields.
e Enter avalid Type between 001 and 999.

e Click on List. The Document Type List dialog box
displays; this list is derived from the docs.ini file. Select a
type and click on OK. The document type you choose is
active until you change it.

& Document Type List @

loo2  POD Proof of Delivery LA
003 CHEK Check

non4 COHTRACT Contract

005 CUSTIHV Customer Invoice

006 SPRDSHT Spreadsheet

oo? PO Purchase 0Order

00a HMEMO Hemo W

Note: The document types that actually display here
depends on the current user’s image type security privileges.
If you do not see a type code here that you expect to see,
contact your TMAGE system administrator to verify that
image type security has been set correctly.
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3. Review the image and populate the displayed pre-index

fields. Press Tab to move from field to field. Click on New to
clear all fields.

Note: Required keys will have a white background in the Key
field. Keys that are not required will have a gray background.
This is for pre-indexing by document in single scan mode
only.

Pre-Index by Document
Type 001-999

m Hew | List |

Purchase Order

Customer Hame

Date

Invoice Number

Scan | Rescan | Close |

If you neglect to populate a pre-index field that matches a
required key, the following message displays.

Input Required

Pre-index field

name
1 'j Input is required for Cusfomer Name Field
.

If entered data does not conform to validation parameters,
an error message box, similar to the example below, displays.

Data Type Error

L] E Date must be in MM/DDJYY oF MM-DD-¥Y Form
.

When you have populated all required fields, do one of the
following:

e click Scan to continue
e click Rescan to scan the current image again
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Begin scanning

Click the Scan icon on the toolbar or press F2 to begin scanning.
If you are Pre-Indexing, then click the Scan button on the Pre-
Indexing by Document screen or on the Continuous Pre-
Indexing screen.

The counter is incremented by 1 and the scanner takes the next
piece of paper from its bin, scans it, and writes the digitized
record to the capture path. When the image is scanned, the date
and time stamp from the PC’s CPU is stored in each image’s data
record (image.dat).

Continuous If you selected Continuous scan mode, then the

scan mode scanner continues to feed documents and scan
until it runs out of paper, becomes jammed, or
an error occurs. You may be unable to break
out of continuous scanning because this is
hardware dependent; therefore, it is best to
remove all remaining documents from the
feeder to stop continuous scanning.

The way your scanner detects the “out of
paper” message depends on your scanner type.
Some scanners immediately display the 1Scan
error message box with the message “Scanner
Out Of Paper” while other scanners send the
message after trying to feed a document for
the time period entered in the Timeout field in
Scanner Properties.

Single scan If you selected Single scan mode, then the
mode scanner scans one document and stops. If you
have chosen to pre-index, do so at this time.

Review Images Scanned in Batch Mode

Batch mode scanning is an effective solution for 1Scan users to
retain batch name information at scan-time. This batch name

information is made available to the image server so that it can
organize images to be indexed into easily identifiable batches.

As of 1Scan version 7.3.3, this feature also provides 1Scan users
the ability to review their images, reorder the images, delete
selected images or even delete the entire batch. This enhances
1Scan’s ability to ensure the quality of images that are being
sent to the image server. All images scanned in batch mode now
have access to this feature.

Tmage Software Inc.

1Scan User Guide, ©2019 80



1Scan general procedures

This feature adds an additional step to the image transfer

process. Batch mode scanning creates a temporary directory

that contains the batch images. When the batch session is
terminated, the images are transferred from the batch directory
to the capture path.

To access batch mode features select “Batch” on the menu bar.

15can s10001 3 2. 1if

Eile Scanner Server  wiew NEEEe

Opkions  Pre-Indexing  Help

T 2 [ 2 |8

L
L
L

i)

Meww Bakch Chrl+E
First Image

Previous Image

Mext Image

Last Irnage

Goto Image ... Chrl+a
Zuk Image Chrl4n
Delete Image  Del
Delete Batch

This menu item provides the following functions related to Batch

handling:
Batch Menu Function
Item
New Batch Opens a new batch.
FirstImage Displays first image in batch.

Previous Image
Next Image
Last Image

Goto Image

Cut Image

Paste Image

Delete Page

Delete Image

Displays previous image in batch.
Displays next image in batch.
Displays last image in batch.

Allows user to specify which image in batch
to display.

Copies the current image into memory to
be pasted in another location within the
same batch.

Pastes an image that has been cut.

Deletes a single page from a displayed
duplex image. This option is only available
in duplex mode.

Deletes the currently displayed image. Ifin
Duplex mode, this will delete both front
and back of the displayed image.
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Delete Batch Deletes entire contents of current batch.

To scan in batch mode
1. Open 1Scan in batch mode. See “Enable the Batch Code

option” on page 16 for information about configuring 1Scan
for batch mode.

Enter Batch name when prompted.

Note: If the name of an existing batch is entered, then the
first image of that batch displays.

Scan images. Images will be placed in the named batch until
a new batch is opened.

Inspect images by doing any of the following:

e Review images - Click Batch > Next Image or Batch >
Previous Image to display each image in the batch, or
press the Page Up and Page Down keys.

¢ Move animage in a batch. See “To reorder imagesin a
batch” on page 83.

e Delete image from a batch. See “To delete imagesin a
batch” on page 84.

e Delete the batch. See “To delete a batch” on page 84.

. Transfer images to the capture path as defined in Tool Scan

by clicking File > Transfer Images or by pressing F11. A
message box requesting confirmation to transfer the images
from the current batch will display.

Note: Once the images have been transferred from the
batch, they are no longer available for inspection.

The user is prompted to transfer batch images when they
attempt to exit the current session. If the user chooses to exit
their current session without transferring the batch images,
the batch images will be available for inspection or for
adding new images the next time the user opens that same
batch.

Click No to cancel this request and to return to the batch
session. Click Yes to transfer the images.

On pre 8.1 image server environments the images are then
transferred to the capture path defined in Tool Scan. A
message box displays requesting confirmation to transfer the
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images to the directory as defined by the Transfer Method in
Tool Scan. If “Nothing” is defined as the transfer method
then the user will not be prompted.

Note: When Auto Batch Transfer is selected, the user is not
prompted to transfer batch images to the capture path.
Images are automatically transferred whenever the user exits
1Scan or changes to another batch.

On 8.1 image server environments the images are transferred
directly into the specified queue directory on the image
server

6. Click Yes to transfer images from the capture path to the
directory as defined by the Transfer Method in Tool Scan.
Click No to leave the image in the capture path.

Note: If the user clicks No, they will be prompted again to
transfer any images left in the capture path the next time the
user exits 15can.

To reorder images in a batch

Batch mode scanning allows the reordering of images within a
batch. After images have been scanned, they can be “cut” from
their current location, then “pasted” to a new location within the
same batch. Images may not be “cut” from one batch and
“pasted” to another. Use the following procedure to move an
image from on location to another:

1. Select the image to move by paging up or down to display
the image in the 1Scan display area.

2. Cuttheimage from its current location by either clicking
“Cut” from the Batch menu, or by pressing CTRL-X on the key
board. The image will be copied into memory.

Note: the image will still display in it original location until
the “Paste” operation has been completed.

3. Page up or down to the location where the image will be
placed. Display the image that will immediately follow this
placement.

4. Paste the image to its new location by either clicking “Paste”
from the Batch menu, or by pressing CTRL-V on the
keyboard. The selected image will display in its new location.
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To delete images in a batch

Deleting images allows you to remove poor quality images from
the batch. When scanning in single scan mode Delete Image will
delete the image that is currently displayed. Use the following
procedure to delete an image:

1. Select the image to delete by paging up or down to display
the image in the 1Scan display area.

2. Delete the image by either clicking “Delete Image” from the
Batch menu, or by pressing Delete on the keyboard.

When scanning in duplex mode Delete Image will delete both
the front and back page of the image that is currently displayed.
If you wish to delete a single page of a duplexed image then
click on the page to be deleted and click “Delete Page” from the
Batch menu. The selected page will be deleted. If the front page
of a duplexed image is deleted, then the back page will be
redisplayed in the front page panel.

To delete a batch

Use the Delete Batch option to delete the entire contents of a
batch. This option may be helpful in deleting a set of images
that have not been scanned correctly resulting in poor image
quality or wrong patch code / bar code information. Use the

following procedure to delete a batch.

1. Click File > Delete Batch. A message box displays requesting
confirmation delete the batch.

2. Click No to cancel the delete batch request. Click Yes to
delete the batch. A Batch Code dialog box displays
prompting the user to enter a new Batch Name.

3. Enter a new batch name. A new batch session displays.

Note: If the user enters the name of an existing batch, then
the images in that batch will display and will be available for
review.

To rescan a document

Rescan if:

e The document is scanned wrong side up, bottom first, or
while folded or crumpled.
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e The scanner does not make a readable image. (If
rescanning does not work, adjust the settings on the
scanner.)

e The scanner jams, runs out of paper, or goes off-line.

If you are scanning a batch of documents when you experience
some system problem, resolve the problem and resume the
scanning process. To ensure that the image last displayed in the
view window is captured for indexing, use this rescan procedure:

1. Return the document to the scanner’s bin so that it is the
next document to be scanned.

2. Do one of the following:

Click on the @Jﬁ button on the tool bar

Click Scanner > Re-Scan from the main menu

Press F3

Click on the Re-Scan button on the Pre-Index by
Document window

The previously scanned image (the unacceptable one) is
replaced with the rescanned version. The sequence number
is not incremented.

Adjustments to a 1Scan .dat file

.dat files are data files that store information about each image
file to be used for indexing. These files are created by 1Scan at
scan time. Each image file created will have an associated .dat
file. The following procedures discuss some of the ways the
information is written to the .dat files

To change batch code names

The procedure for changing batch code names is slightly
different for 1Scan connecting to an 8.1 image server than it is
for connecting to an 8.0a or earlier image server.

If you are connecting to an 8.1 image server

If Batch Code is enabled in Tool Scan, the user has the option to
change both the batch and the queue. Users may only change
queues if the have more than one queue they can access.
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15can - Select Queue And Batch

Scan Queue: |.-'1'-.E!E QUEUE 1
Batch Mame: |

[~
=l

ag. Cancel |

To change the batch and or queue,

Select New Batch from the Batch Menu item

File Scanner Server View NEENag® Opotions  Pre-Indexing  Help
Mew Batch Chrl+

First Irnage

Previous Image

Mexk Image:

Last Image

Goto Image ... Chr4+G

Cut Image Chrl+x

Delete Image Dl

Delete Bakch  Chr4D

1 e e [ R (R

=

The Select Queue and Batch dialog box displays.

15can - Select Queue And Batch

Scan Queue: |.-'1'-.BE GUELE 1 j
Batch Mame: | j

ag Cancel |

2. Click the pull down button in the Scan Queue field to reveal
the complete list of scan queues available to this user. Select
the new queue from this list.

3. Select a new batch from the list of available batches by
clicking the pull down button in the batch name field or
enter a new batch name.

4. Click OK

If Batch Code is not enabled in Tool Scan, the user still has the
option to change the queue. Users may only change queues if
the have more than one queue they can access
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15can - Select Queue

Scan Quele:

k. Cancel

To change queue,
1. Select New Queue from the Queue menu item.

SIS Options  Pre-Indexing  Help

Mew Quels ChrHN

File Scanner Server \iew

Delete Queue  Chrl+D

e | [ [ R K

The Select Queue dialog box displays.

15can - Select Queue

Scan Quele:

ag. Cancel |

Click the pull down button in the Scan Queue field to reveal
the complete list of scan queues available to this user. Select
the new queue from this list.

3. Click OK
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If you are connecting to an 8.0a or earlier image server

If Batch Code is enabled in Tool Scan, then the Batch menu is

enabled.
1. Select New Batch from Batch. The Batch Code dialog box
displays.

. Batch Code

Mew B atch Code: || |

ok, | Cancel |

2. Enter a New Batch Code. You may use alpha or numeric
characters. Do not use spaces or special characters.

3. Do one of the following:

e C(lickon OK to accept. The new batch code name is saved
in the *B field in all .dat files created by this batch.

e C(lick on Cancel to leave without saving your changes.

4 To attach a comment to an image (single scan mode only, no
pre-indexing)

If you have selected single scan mode and no pre-indexing, you
can attach an unlimited number of characters per comment to
animage. Comments are recorded in the data file (image.dat)
and will display in the TNOTES window for this document after
indexing.

1. Click Add Comment on the 1Scan Options menu. The
Comments dialog box displays.

&, Comments

Cancel

2. Type acomment.

3. Click on OK. The comment is recorded in the * C field of the
.dat file.

Click on Cancel to exit without saving your changes.
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Note: Previously entered comments do not appear if you re-
display the COMMENTS dialog box. However, changes can
be made to a previously recorded comment by adding an
additional comment.

In duplex mode, comments may be added to the front, back or
both pages of a duplexed image. To add a commentto a
duplexed page, single-click either the front or back page in the
1Scan display area to give focus to the desired page. Then click
the Add Comment icon from the Tool Bar. Any text entered in
the Comments dialog box will be applied to the .dat file
associated with the selected page.

L 4 To link images together when scanning multi-page documents

& 1Scan permits you to link multi-page documents during
the scanning process; however, if you choose not to link
documents during the scanning process, you have a second
opportunity to link them either by using IM110, Index Entry in the
telnet interface or by using TMAGE’s manual indexing process in
1Suite.

1Scan puts a *A into the .dat file of the page that is added.

1. Insingle scan mode, scan the first page of a multi-page
document.

2. Scan the next page of a multi-page document.

3. Click on Add. The message, “Add this page to previous
page?” displays.
4. Click on OK or press Enter.

Repeat steps 2 to 4 for all pages of the document.

L 4 To add an image to a previously scanned image

When scanning in batch mode, 1Scan allows the user to add a
page to a previously scanned image within the current batch.
To add an image to any other image within the batch:

1. Scananimage.

2. Press the Page up key or click Batch > Previous to display the
page to add the newly scanned image.

3. Click the Add Page button on the tool bar or click Options >
Add Page. 1Scan puts a *A into the .dat file of the page that
is added.
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Common problems and their solutions

If image processing seems exceedingly slow

Most image processing speed problems are the result of a less
than optimal pre-scan cache setting in Scanner Properties.

The Prescan Cache setting defaults to 3 when 1Scan is installed.
Tune up or down from that number to get the optimal setting
for configuration of Kofax card, RAM, scanner, and 1Scan
features.

If 1Scan exits abnormally

Check the Prescan Cache setting in 1Scan > Scanner Properties >
Options. If pre-scan cache is set too high, the software will
simply close because the memory on the Kofax card is
insufficient. Tune the setting down and test to get the optimal
setting for your configuration of Kofax card, RAM, scanner, and
1Scan features.

Important: 1Scan settings are saved when you exit normally.
If you exit abruptly or abnormally, the sequence number is not
updated. Clear all images from the current session that remain
in your batch directory (or capture directory if appropriate), re-
configure the settings, and scan the documents again. If you do
not do this, you risk overwriting images scanned, but not yet
indexed.

If communications lock up

Do one of the following:

e Check the connections between the PC and scanner
e Press the Clear or Stop buttons on the scanner.
e Turn the scanner off and then on again.

One of these might recover communications, in which case you
can go back to 1Scan by pressing any key. If communications
are still locked up, re-boot your computer.

If you get a communication error

Open KSM (Kofax Source Manager) and confirm that your
scanner is listed as the default scanner.
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If you switched capture directories and 1Scan does not work (when connecting to
1MAGE Server versions 8.0a or earlier)

If you switched your capture directory to a Network File System
(NFS) mount and 1Scan does not work, switch the capture
directory to the PC’s hard drive and scan to a directory there. If
1Scan works with this configuration, then you have a network
problem, not a software problem. See your System
Administrator.

If 1Scan is not reading patch codes

Patch codes follow a much more stringent set of specifications
than bar codes. This factor, and because the patch code image is
much larger than a bar code image, makes patch code
recognition much easier than bar code recognition.

If the patch codes meet specifications, the patch code pattern
should be recognized even with poor quality images. If the
patch code is not being recognized due to poor quality, then the
image itself will probably be unacceptable to 1Scan.

However, if Patch Codes are not being read, confirm that the
“Left Offset to Center of Patch Code” setting on the Patch Code
Properties screen is set to 0. This will enable 1Scan to read patch
codes under most conditions.

Data from patchcode page not written to dat file.

Verify the following:

e The Maximum Bar Codes Per Page setting on the Bar Codes
Properties screen is greater than the number of bar codes on
the PatchCode sheet.

e Bar code reading is enabled.

If 1Scan is not reading barcodes
Confirm that Bar Code Recognition is enabled.

Confirm that bar code property settings for height, width and
type are valid for the bar codes being scanned.

Confirm that VRS settings for Erosion / Dilation Filter and Speckle
Removal Filter are not removing bar code elements from the
image.

If 1Scan is reading some, but not all barcodes on a patch code page

Confirm that the Max Bar Codes Per Page setting is greater than
the total number of bar codes present on the patch code page.
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If FTP does not work (when connecting to 1TMAGE Server versions 8.0a or earlier)
Ask your System Administrator to check login, permissions, and
server’s availability.

If you received an error message and re-booting the scanner did not solve your

imaging control problem
Reset the engine. See Resetting the image control board
(engine) on page 94 for instructions on resetting the engine.

If the Type Code List dialog box does not display all the Type Codes in Pre-Index

mode (when connecting to 1MAGE Server versions 8.1 or later).

Ask your System Administrator to confirm whether you have

access to the missing type code.

If message “You are not authorized to apply type code: <###>" (when
connecting to 1TMAGE Server versions 8.1 or later).

Authorization Error E]

L] "_v. ou are not authorized to apply type code; 012
L

If you received this message while using patch code sheets to
apply type code information to the image at scan time, you have
scanned a document containing a Document Type bare code
that is not authorized for your 1Scan login name. 1Scan stops
scanning as soon as it detects a bar code that attempts to apply
a type code to an image that the current user is not authorized
to view. All documents following the offending patch code
sheet are deleted.

Remove all documents from the scanner’s document feeder and
verify that a different patch code sheet is in place before clicking
OK. If an out of paper message displays, you will also need to
click Cancel on this message box as well.

If you received this message while pre indexing, then you have
attempted to enter a type code in the Types field on the Pre
Index dialog box that is valid, but that you do not have privileges
to access. Click List to display a list of valid type codes for 1Scan
login name. Select a valid type code from the list and click OK.
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Table of common error messages

The following table contains error messages that might be
encountered while scanning.

To fix this error

Do this

Access violation

If using an NFS mount, ask your System Administrator
to check the directory for appropriate user permissions.

Data overflow

Appears if the DPI is set too high and the scanner board
could not handle the size of the image. Use Scanner Set
up to switch to a lower DPI or increase the memory on
the Kofax board.

Disk or directory is full

Appears if images are stored on the PC: check to see if
the images need to be transferred, try to scan again; if
not successful see your System Administrator.

Peripheral not configured

Appears if the scanner was not turned on and initialized
before the PC was booted. Boot the scanner and then
re-boot the PC.

Peripheral not ready

Wait for the scanner to initialize and try to scan again.

Scanner is jammed

Free the paper jam and re-scan the jammed document.

Scanner Out of Paper

Fill the paper tray and continue scanning.

System memory allocation
error

Close other applications and continue scanning or
check your memory configuration requirements. If you
cannot recover, exit and restart Windows.

Timeout waiting for engine
or device

Check the scanner to see if it is functioning properly
and scan again.

Troubleshooting procedures

Resetting the image control board (engine)

A scanner’s image control board, or engine, is automatically
configured and its memory is cleared whenever the scanner is
booted or re-booted. The board may be manually configured
and its memory cleared without re-booting the scanner by
selecting the option Reset Engine. To reset the engine:
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From the Scanner menu, select Reset Engine. The Reset
window displays the current status as the board’s memory is
cleared and it is reconfigured. The message Kofax Engine
Loaded Successfully displays when the engine is reset.

=-‘~__ §- K.ofax Image Products IMGCTLS
=21 Copyright © 1933-2001 WIE7.18

Kofax Engine Loaded Successtully

Note: This window may display too quickly to be viewed
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